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.IMG IMAGINE file  

.mdb geodatabase file 

.TIF tagged image file 

DEM Digital elevation model 

FEMA Federal Emergency Management Agency 

FIRM Flood Insurance Rate Map 

FIS Flood Insurance Study 

FIT Flood Information Tool 

GBS General Building Stock 

GIS geographic information system 

HEC-RAS Hydrologic Engineering Center’s River Analysis System 

Hurrevac hurricane evacuation tool 

NAVD  North American Vertical Datum 

NOAA National Oceanic and Atmospheric Administration 

RES1 Single-Family 

SLOSH Sea, Lake, and Overland Surges from Hurricanes (model) 

SWAN Simulating WAves Nearshore (model) 

SWEL stillwater elevation 

UDFs User-Defined Facilities 

USACE U.S. Army Corps of Engineers 

USGS U.S. Geological Survey 

WHAFIS Wave Height Analysis for Flood Insurance Studies 
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Section 1. Introduction 

1.1 Background 
The Hazus Flood Loss Estimation Methodology provides state, local, tribal, and territorial (SLTT) 
officials with a decision support software for estimating potential losses from flood events. This loss 
estimation capability enables users to anticipate the consequences of floods and develop plans and 
strategies for reducing risk. The Geographic Information System (GIS) based software can be applied 
to study geographic areas of varying scale with diverse population characteristics and can be 
implemented by users with a wide range of technical and subject matter expertise. 

This Methodology has been developed, enhanced, and maintained by the Federal Emergency 
Management Agency (FEMA) to provide a tool for developing flood loss estimates for use in: 

 Anticipating the possible nature and scope of the emergency response needed to cope with a 
flood-related disaster. 

 Developing plans for recovery and reconstruction following a disaster. 

 Mitigating the possible consequences of floods. 

The Hazus Flood Model provides the capability to quantify potential building impacts and losses, and 
social parameters such as shelter needs. The model analyzes flood hazards from a variety of inputs 
or can develop a flood hazard using probabilistic parameters set by the user.  

The current capability addresses all fifty states and Caribbean territories and includes both riverine 
and coastal models. This flood methodology was developed by FEMA in the early 2000s and is 
updated with ongoing modifications based on newer methodology or software development. It is 
intended to help guide the allocation of federal resources to stimulate risk mitigation efforts and to 
plan for a flood-related disaster response at all levels of government. 

This Hazus Flood Model User Guidance outlines the background and instructions for developing a 
Study Region and defining a scenario to complete a flood loss estimation analysis using Hazus. It 
also provides information on how to modify inventory, improve hazard data and analysis parameters 
for advanced applications, and guidance on calculating and interpreting loss results. 

The Hazus Flood Model Technical Manual (FEMA, 2021) documents the methods used in calculating 
losses. A companion document, the Hazus Inventory Technical Manual (FEMA, 2021), provides more 
detailed methodology and data descriptions for the inventory shared by each hazard model. 
Together, these documents provide a comprehensive overview of this nationally applicable loss 
estimation methodology across Hazus. 
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1.2 Hazus Users and Applications 
Hazus can be used by various types of users with a wide range of informational needs. A SLTT 
government official may be interested in the costs and benefits of specific mitigation strategies, and 
thus may want to know the expected losses if mitigation strategies have (or have not) been applied. 
Health officials may want information regarding the demands on medical care facilities and may be 
interested in social impacts for different flood scenarios. Emergency response teams may use the 
results of a loss study in planning and performing emergency response exercises. They might be 
interested in the operating capacity of emergency facilities such as fire stations, emergency 
operations centers, and police stations. Emergency planners may want estimates of temporary 
shelter requirements for different flood scenario events. Federal and state government agencies may 
conduct a loss analysis to obtain quick estimates of impacts immediately following a flood to best 
direct resources to the disaster area. Insurance companies may be interested in the estimated 
monetary losses so they can determine asset vulnerability. 

Flood loss estimation analyses have a variety of uses for various departments, agencies, and 
community officials. As users become familiar with the loss estimation methodology, they can 
determine how to use it to best suit their needs, and how to appropriately interpret the study results. 

The products of Hazus analyses have several pre- and post-flood applications in addition to 
estimating the scale and extent of damage and disruption. Examples of pre-flood applications of the 
outputs include: 

 Development of flood hazard mitigation strategies that outline policies and programs for 
reducing flood losses and disruptions indicated in the initial loss estimation study. Strategies can 
involve rehabilitation of hazardous existing buildings (e.g., unreinforced structures in a high-risk 
flood zone), building code enforcement, development of appropriate zoning ordinances for land 
use planning in flood inundation zones, and the adoption of advanced building codes. 

 Development of preparedness (contingency) planning measures that identify alternate 
transportation routes, social preparedness, and public education. 

 Anticipation of the nature and extent of response and recovery efforts including the identification 
of alternative housing; the location, availability, and scope of required medical services; and the 
establishment of a priority ranking for restoration of water and power resources.  

Post-flood applications of the outputs include: 

 Projection of immediate economic impact assessments for state and federal resource allocation, 
and support for state and/or federal disaster declarations by calculating direct economic impact 
on public and private resources, local governments, and the functionality of facilities in the area. 

 Activation of immediate emergency recovery efforts including search and rescue operations, 
rapid identification and treatment of casualties, provision of emergency housing shelters, and 
rapid repair and availability of essential utility systems. 
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 Application of long-term reconstruction plans that include the identification of long-term 
reconstruction goals, implementation of appropriate wide-range economic development plans for 
the impacted area, allocation of permanent housing needs, and the assessment of land use 
planning principles and practices. 

1.3 Assumed User Expertise 
Users can be divided into two groups: those who perform the analysis and those who use the 
analysis results. For some analyses, these two groups occasionally consist of the same people. The 
more interaction that occurs between these two groups, the better the analysis will be. End users of 
the loss estimation analysis need to be involved from the beginning to make results more usable.  

Any risk modeling effort can be complex and would benefit from input from an interdisciplinary group 
of experts. A flood loss analysis could be performed by a representative team consisting of the 
following: 

 Floodplain managers 

 Structural engineers or architects 

 GIS professionals 

 Economists 

 Sociologists 

 Emergency planners  

 Loss analysts 

The individuals needed to perform the study can provide valuable insight into the risk assessment 
process and will depend on the desired level of analysis, explained in greater detail in Section 2.3. In 
addition to subject matter expert involvement, at least one GIS specialist should participate on the 
team. 

If a SLTT agency is performing the analysis, some of the expertise may be found in-house. Experts 
are generally found in several departments: building permits, public works, planning, public health, 
engineering, information technologies, finance, historical preservation, natural resources, and land 
records. Although internal expertise may be most readily available, the importance of the external 
participation of individuals from academic institutions, citizen organizations, and private industry 
cannot be underestimated.  

1.4 When to Seek Help 
The results of a loss estimation study should be interpreted with caution because default input 
values have a great deal of uncertainty.  
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If the loss estimation team does not include individuals with expertise in the areas described in 
Section 1.3, one or more consultants will likely be needed to help interpret the results. It is also 
advisable to retain objective reviewers with relevant expertise to evaluate the map and tabular data 
outputs. A floodplain manager, hydrologist, or hydraulic engineer may be needed to provide 
deterministic or probabilistic scenario data or review the software parameters.  

If the user intends to modify the default inventory data or parameters, assistance will be required 
from an individual with relevant expertise. For example, if the user wishes to change the default 
percentages of foundation types in a region, a structural engineer with knowledge of regional design 
and construction practices would be helpful. Modifications to defaults in the economic loss models 
will require input from an economist. 

1.5 Technical Support 
Technical Support contact information is provided in the Hazus application at Help > Obtaining 
Technical Support; technical assistance is available via the Hazus Help Desk by email at 
FEMA-Hazus-support@fema.dhs.gov (preferred) or by phone at 1-877-FEMA-MAP (1-877-336-2627). 
The FEMA Hazus website also provides answers to Frequently Asked Questions, and information on 
software updates and training opportunities. 

FEMA-provided resources also include the Hazus Virtual Training Library, a series of short videos 
arranged into playlists that cover various Hazus topics, from an introduction to Hazus methodologies, 
to targeted tutorials on running Hazus analyses, to best practices when sharing results with decision 
makers. This easily accessible learning material provides quick topic-refreshers, free troubleshooting 
resources, and engaging guides to further Hazus exploration. 

The application’s Help menu references the help files for ArcGIS. Since Hazus was built as an 
extension to ArcGIS functionality, knowing how to use ArcGIS and ArcGIS Help Desk will help Hazus 
users. 

Technical support on any of the four hazards is available in the contacts shown via Help > Obtaining 
Technical Support. 

1.6 Uncertainties in Loss Estimates 
Although the software offers users the opportunity to prepare comprehensive loss estimates, even 
with state-of-the-art techniques, uncertainties are inherent in any estimation methodology. The Flood 
Model is only a tool for loss estimation from modeled flood events. Hazus does not compute 
uncertainties in the loss estimates, provide ranges for possible losses, or offer any confidence levels. 
The output of hard numbers is tied to the input data. Uncertainties may be estimated, but Hazus 
does not output such statistics.  

 

mailto:FEMA-Hazus-support@fema.dhs.gov
https://www.fema.gov/flood-maps/products-tools/hazus
https://www.youtube.com/user/FEMA/playlists?view=50&sort=dd&shelf_id=8
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Section 2. Overview of the Flood Model 
This brief overview of the Flood Methodology is intended for SLTT officials contemplating a flood 
analysis. 

The Flood Model will generate an estimate of the consequences to a county or region of a scenario 
flood (i.e., a flood of a specified magnitude). The resulting "loss estimate" will generally describe the 
scale and extent of damage and disruption that may result from the modeled flood event. The 
following information can be obtained: 

 Quantitative estimates of structural damage based on specific building and occupancy types that 
delineate how and to what extent a structure can be damaged by varying flood water depths. 

 Quantitative estimates of losses in terms of direct costs for repair and replacement of damaged 
buildings, direct costs associated with loss of function (e.g., loss of business revenue or 
relocation costs). 

 Estimates of social and infrastructure impacts. 

To generate this information, the Methodology includes: 

 Classification systems used in assembling inventory and compiling information on the General 
Building Stock (GBS), demographic, and economic data. 

 Standard calculations for estimating type and extent of damage, and for summarizing losses. 

 National and regional databases containing information for use as baseline (built-in) data 
useable in the calculation of losses if there is an absence of user-supplied data. 

These systems, methods, and data have been combined in a user-friendly GIS software for this loss 
estimation application. 

The Hazus software uses GIS technologies for performing analyses with inventory data and 
displaying losses and consequences on applicable tables and maps. The Methodology permits 
estimates to be made at several levels of complexity, based on the level of inventory data entered for 
the analysis (i.e., baseline data versus locally enhanced data). The more concise and complete the 
inventory information, the more accurate the results. 

The following figure provides a graphic representation of the modules that the Hazus Flood Model 
Methodology is comprised of, and their interrelation in deriving estimates. 
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Figure 2-1 Hazus Flood Model Methodology Schematic 

While Figure 2-1 shows the conceptual relationships, the steps used in the Hazus Flood Model are as 
follows: 

 Select the area to be studied: The Hazus Study Region (the region of interest) is created based 
on Census block, tract, or county level aggregation of data. The area generally includes a city, 
county, or group of municipalities. It is generally desirable to select an area that is under the 
jurisdiction of an existing regional planning group. 

 Specify the Flood hazard scenario: In developing the scenario, flood consideration should be 
given to the availability of data including depth grids or elevation models from HEC-RAS or lidar-
derived sources  

 Integrate local inventory data: Include user-defined facilities and updates to GBS characteristics. 

 Use the formulas embedded in Hazus: Compute probability distributions for damage to different 
classes of buildings, facilities, and infrastructure system components.  



Hazus Flood Model User Guidance 

 Page 2-3 

 Compute estimates of direct economic loss, infrastructure, and social impacts using the damage 
and functionality information.  

The user plays a major role in selecting the scope and nature of the output of a loss estimation 
analysis. A variety of maps can be generated for visualizing the extent of the losses. Generated 
reports provide numerical results that may be examined at the level of the Census block, tract, or 
aggregated by county or region. 

2.1 Flood Hazards in the Flood Model 
The Hazus Flood Model analyzes both riverine and coastal flood hazards. Flood hazard is defined by 
a relationship between depth of flooding and the annual chance of inundation to that depth. 

Depth, duration, and velocity of water in the floodplain are the primary factors contributing to flood 
losses. Other hazards associated with flooding that contribute to flood losses include channel 
erosion and migration, sediment deposition, bridge scour, and the impact of flood-borne debris. The 
Hazus Flood Model allows users to estimate flood losses from depth of flooding. The Flood Model 
does not estimate the losses due to high-velocity flash floods. 

In different contexts, flood hazard may have different meanings. Hazard can mean risk in some 
contexts, and it can mean a source of danger in others. The hazard may be that an area is inundated 
about once every 10 years (risk), or it may be that an area is subject to flood depths ranging from 5 
to 10 feet (source of danger). Flood frequency studies combine these ideas and define flood hazard 
in terms of the chance that a certain magnitude of flooding is exceeded in any given year.  

Flood magnitude is usually measured as a discharge value, flood elevation, or depth. For example, 
flood magnitude may be referred to as the 100-year flood elevation, which is the elevation, at the 
point of interest, that has a 1% annual chance of being exceeded by floodwater. Using the flood 
frequency convention, flood hazard is defined by a relation between depth of flooding and the annual 
chance of inundation greater than that depth. The relation is called a depth-frequency curve.  

2.2 Definitions of Structures 
There are differences between terminology used to designate distinctions between types or 
categories of structures. The term “structure” refers to all constructions, such as a building, bridge, 
water tank, shed, carport, or other man-made thing that is at least semi-permanent. A building is a 
structure with a roof and walls that is intended for use by people and/or inventory and contents, 
such as a house, school, office, or commercial storefront. A facility corresponds to a particular place, 
generally a building, with an intended purpose such as a school, hospital, electric power station, or 
water treatment facility. Some facilities are defined as ‘essential facilities’ meaning the facility is 
critical to maintaining services and functions vital to a community, especially during disaster events. 
The buildings, essential facilities, and transportation and utility systems considered by the 
Methodology are as follows: 
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 General Building Stock: The key General Building Stock (GBS) databases in Hazus include square 
footage by occupancy and building type, building count by occupancy, and building type, building 
and content valuation by occupancy and building type, and general occupancy mapping.  The 
GBS commercial, industrial, and residential buildings in a region are not considered individually 
when calculating losses. These buildings within each Census block are aggregated and 
categorized. Building information derived from Census and employment data are used to form 
groups of 33 specific occupancy classes, seven foundation types, and five general building types 
(additional information on the Hazus baseline GBS inventory data is provided in the Hazus 
Inventory Technical Manual (FEMA, 2021). Degree of damage is computed for each grouped 
combination of model building type and occupancy class.  

 User-Defined Facilities (UDFs): A template database is available in Hazus to enter individual 
accurate results. structures to be analyzed, instead of or in addition to the aggregated GBS. 
Template databases are available in Hazus if the user is comfortable working with SQL Server. 
More information on how to set up a UDF database can be found in Section 9 of this document, 
the Hazus Inventory Technical Manual (FEMA, 2021) or in the documentation and sample 
databases accompanying the Hazus FAST tool. Use of individual, site-specific data is highly 
encouraged for more  

2.3 Levels of Analysis 
Hazus is designed to support two general types of analysis (Basic and Advanced), split into three 
levels of data updates (Levels 1, 2, and 3). Figure 2-2 provides a graphic representation of the 
various levels of analysis. 

 
Figure 2-2 Levels of Hazus Analysis 
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2.3.1  Analysis Based on Baseline Information 
The basic level of analysis uses only the baseline databases built into the Hazus software and 
Methodology on building square footage and value, population characteristics, costs of building 
repair, and certain basic economic data. This level of analysis is commonly referred to as a Level 1 
analysis. In a basic analysis (Level 1), the user must specify a drainage area for stream network 
delineation, and Hazus will use these inputs to estimate a depth grid for the study region. Direct 
economic and social losses associated with the GBS, and essential facilities are computed. Baseline 
data for transportation and utility systems are included; thus, these systems are considered in the 
basic level of analysis. However, there is a significant level of uncertainty pertaining to the estimates. 

Other than defining the Study Region, selecting the scenario flood(s), and making decisions 
concerning the extent and format of the output, an analysis based on baseline data requires minimal 
effort from the user. As indicated, the estimates involve large uncertainties when inventories are 
limited to the baseline data. This level of analysis is suitable primarily for preliminary evaluations and 
comparisons among different Study Regions. A basic Level 1 analysis could be used for comparisons 
and preliminary evaluations to assist in identifying potential mitigation actions within a community, 
which could be useful if evaluating funding priority for projects. 

2.3.2 Analysis with User Supplied Inventory 
Results from an analysis using only baseline inventory data can be improved greatly with at least a 
minimum amount of locally developed input. Improved results are highly dependent on the quality 
and quantity of improved inventory data. The significance of the improved results also relies on the 
user’s analysis priorities. This level of advanced analysis is commonly referred to as a Level 2/Level 
3 analysis. The following inventory improvements impact the accuracy of Level 2/Level 3 Advanced 
Analysis results: 

 Use of locally available data or estimates of the square footage of buildings in different 
occupancy classes. 

 Use of local expertise to modify the mapping scheme databases that determine the percentages 
of specific building types associated with different occupancy classes. 

 Preparation of a detailed inventory of all essential facilities and infrastructure. 

 Use of locally available data concerning construction costs or other economic parameters. 

 Level 2 or 3 hazard data can also be incorporated in the form of independently generated depth 
grids. Sources for these grids may include local engineering offices, state water departments 
with access to lidar products, adapted DFIRMs from FEMA, or the HEC-RAS tool.  
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Section 3. Getting Started Part 1: Hazus Startup Screen 
The Hazus Startup screen is the first screen users will see after launching Hazus.  

3.1 Hazus Startup 
Before running a loss estimation analysis, users must define a Study Region. The Study Region in 
Hazus is the geographic unit for which data are aggregated, the flood hazard is defined, and the 
analysis is carried out. Before starting, make sure that the appropriate state(s)’s Hazus data have 
been downloaded and extracted here: C:\HazusData\Inventory. 

Hazus will prompt users to create a new region or import a previously created region. Users can also 
open, delete, duplicate, backup, or export an existing region. 

3.2 Create New Region 
In the Hazus Startup screen (Figure 3-1), users will take the first step in defining the Study Region. In 
Figure 3-1, Create a new region has been selected. Click OK to activate the window shown in Figure 
3-2.  

Click Next to open the window shown in Figure 3-3 and name the region in the first box (up to 18 
characters, no spaces, and must not begin with a number). Enter a description of the region in the 
second box. This is especially helpful if multiple users will be accessing this region in the future. Click 
Next, which will open the window shown in Figure 3-4. Select Flood from the Hazard Types and click 
Next. This selection cannot be altered later. 

http://msc.fema.gov/portal/resources/hazus
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Figure 3-1 Select Create a New Region in Hazus Startup  

 

 

Figure 3-2 Select Create New Region in Wizard 
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Figure 3-3 Create a Study Region Name 

 

 

Figure 3-4 Select Hazard Type for New Region 
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From the window shown in Figure 3-5, select one of the six aggregation levels. Click Next to open the 
window shown in Figure 3-6. Select the state(s) covered by the Study Region. To select multiple 
states, hold the Shift key while making selections. Click Next to open the window in Figure 3-7. Select 
the county or counties covered by the Study Region.  

Click Next to open the Region Wizard Completion notification shown in Figure 3-8. Click Finish. The 
status window shown in Figure 3-9 will appear. It may take several minutes for the region to be 
created. Once the process is finished, click OK to acknowledge the Study Region has successfully 
been created (Figure 3-10). The Start Menu will reappear. 

 

Figure 3-5 Select Desired Aggregation Level  
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Figure 3-6 Select Appropriate State for the New Region 

 

 

Figure 3-7 Select County for the New Region  
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Figure 3-8 Create New Region Wizard Completion 

 

 

Figure 3-9 Create New Region Progress 
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Figure 3-10 Create New Region Acknowledgement 

3.3 Open Region 
The Open a region option will not be available in the Hazus Startup screen in Figure 3-11 until a 
region has been created or imported. Select Open a region and click OK. The Open Region Wizard 
will appear (Figure 3-12). Click Next. An Open Region list will appear (Figure 3-13). Select which 
region should be opened. Click Next. Verify that the region name and hazard type are correct (Figure 
3-14). Click Finish. Clicking Finish will launch ArcMap. Refer to the additional Hazus User Manuals for 
guidance. 

 

Figure 3-11 Select Open a Region  
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Figure 3-12 Open Region Wizard 

 

 

Figure 3-13 Select the Region to Open  
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Figure 3-14 Open Region Wizard Completion 

3.4 Delete Region 
The Delete a region option will not be available in the Hazus Startup screen in Figure 3-15 until a 
region has been created or imported. Select Delete a region and click OK. A Delete Region list will 
appear (Figure 3-16). Select a region from the list and click Delete to permanently delete the region. 
The Delete Region Confirmation window will appear (Figure 3-17). Click Yes to delete or No to return 
to the Delete Region window (Figure 3-16). Click Done to close the window and return to the Hazus 
Startup screen.  
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Figure 3-15 Select Delete a Region 

 

 

Figure 3-16 Select Region to Delete 
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Figure 3-17 Delete Region Confirmation 

3.5 Duplicate Region 
The Duplicate a region option will not be available in the Hazus Startup screen in Figure 3-18 until a 
region has been created or imported. Select Duplicate a region and click OK. A Duplicate Region list 
will appear (Figure 3-19). Select the region from the list to be duplicated. Click Duplicate. A duplicate 
region confirmation window will appear (Figure 3-20). Click Yes to duplicate or No to return to the 
Hazus Startup screen (Figure 3-18). The Duplicate Region Name dialog will appear (Figure 3-21). 
Enter the name of the new region (18 characters and no spaces) and a brief description. Click OK. A 
progress bar will appear (Figure 3-22). It will close once the region has been successfully duplicated. 
This may take several minutes depending on the size of the region and the speed of the computer. A 
duplicate region completion notification (Figure 3-23) will appear to notify the user that the region 
has been duplicated. Click OK to return to the Duplicate Region list (Figure 3-19). Click Done to 
return to the Hazus Startup screen. 
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Figure 3-18 Select Duplicate a Region 

 

 

Figure 3-19 Select a Region to Duplicate 



Hazus Flood Model User Guidance 

 Page 3-13 

 

Figure 3-20 Duplicate Region Confirmation 

 

 

Figure 3-21 Provide Duplicate Region Name 

 

 

Figure 3-22 Duplicate Region Progress 

 

 

Figure 3-23 Duplicate Region Completed  



Hazus Flood Model User Guidance 

 Page 3-14 

3.6 Export/Backup a Region 
The Export/Backup a region option will not be available in the Hazus Startup screen in Figure 3-24 
until a region has been created or imported. Select Export/Backup a region and click OK. An 
Export/Backup Region list will appear (Figure 3-25). Select the region to export or backup from the 
list. Click Browse to select a file location to save the export/backup. Click Export/Backup. A progress 
bar (Figure 3-26) will appear. It will close once the region has been successfully exported. This may 
take several minutes depending on the size of the region and the speed of the computer. An 
Export/Backup Region Completion notification (Figure 3-27) will appear once the export has 
completed. Click OK. 

 

Figure 3-24 Select Export/Backup a Region 
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Figure 3-25 Select a Region to Export or Backup 

 

 

Figure 3-26 Export/Backup Region Progress 

 

 

Figure 3-27 Export/Backup Region Completed 
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3.7 Import a Region 
Select Import a region from the Hazus Startup screen in Figure 3-28 and click OK. Check the latest 
Hazus version release notes for limitations on importing from previous versions. Hazus is backwards 
compatible by one version. A file explorer will open. Select an export Hazus Packaged Region (.hpr) 
file. In the Imported Region Name dialog (Figure 3-29), enter the name of the region (18 characters 
and no spaces) and a brief description. The name must be different than the imported .hpr file 
name. Click OK. A progress bar (Figure 3-30) will appear. It will close once the region has been 
successfully imported. This may take several minutes depending on the size of the region and the 
speed of the computer. A Region Import Completion notification will appear once the export has 
completed. Click OK. 

 

Figure 3-28 Select Import a Region 
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Figure 3-29 Provide the Name for the Imported Region 

 

 

Figure 3-30 Import Region Progress 

 

 

Figure 3-31 Region Import Completed 
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Section 4. Getting Started Part 2: Basic Hazus Analysis 
The Flood Model allows practitioners to estimate the economic and social losses from flood events. 
The information provided by the model will help state and local officials evaluate, plan for, and 
mitigate the effects of flooding. The Flood Model provides practitioners and policy makers with a tool 
to help reduce flood damage, reduce disaster payments, and make wise use of the nation’s 
emergency management resources. 

Section 4 explains how to run a basic riverine Flood Level 1 GBS Analysis for a single flood event with 
flooding modeled by Hazus. This analysis makes use of Census blocks that have been 
dasymetrically-adjusted based on land cover data, meaning that areas with land cover types that 
typically do not contain structures have been removed from the Census block boundaries. Refer to 
the Flood Technical Manual for information on dasymetric Census blocks and the methodology used 
by Hazus to produce the flood depth raster.  

Launch Hazus and select Open a Region on the Hazus Startup screen (Figure 4-1). Information on 
the other options is provided in Section 3. Click OK, which will open the Welcome to the Open Region 
Wizard (Figure 4-2). Select Next. 

 

Figure 4-1 Open a Region  
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Figure 4-2 Open Region Wizard 

 
In the Select Region window (Figure 4-3), select the desired Study Region. Click Next, which will open 
the Completing the Region Review Wizard (Figure 4-4). Here, the user can review the selected region 
and hazard. Select Finish. An ArcMap window showing the Study Region will open (Figure 4-5). 
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Figure 4-3 Select the Region to Open 

 

 

Figure 4-4 Confirm the Selected Region  
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Figure 4-5 Example – Flood Model in ArcMap 

 
To choose a riverine flood hazard type, open the Hazard drop-down menu and select Flood Hazard 
Type (Figure 4-6). 

 

Figure 4-6 Select Flood Hazard Type in Hazard Menu 

 
Selecting Flood Hazard Type will open the Flood Hazard Type window (Figure 4-7). Select Riverine 
only and click OK.  
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Figure 4-7 Select Flood Hazard Type 

 
To obtain the digital elevation data required for this analysis, open the Hazard drop-down menu, and 
select User Data (Figure 4-8). Please note, it is recommended that users import user-defined flood 
hazard depth grids if available. The Hazus hydrology and hydraulic methodology here should only be 
used if user-defined data are not available. Please refer to Hazus Flood Level 2 Standard Operating 
Procedure published in the FEMA Library for more information. 

 

Figure 4-8 Select User Data in Hazard Menu 

 
Selecting User Data will open the User Data window (Figure 4-9). Click Determine required DEM 
extent.  
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Figure 4-9 Select Determine Required DEM Extent 

 
After a short pause, the DEM Extent window will appear (Figure 4-10). Click Download required DEM 
for Hazus to obtain all the required digital elevation model (DEM) files and save them within the 
Hazus Study Region folder.  
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Figure 4-10 Select Download required DEM 

 
Hazus will take several minutes to download all the DEM files. When the process has completed, a 
notification window will appear (Figure 4-11) to indicate the files have been downloaded and saved. 
Click OK. 

 

Figure 4-11 DEM Downloaded and Saved 
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A popup window (Figure 4-12) will ask the user whether to automatically load the DEM data into the 
User Data window. Click Yes.  

 

Figure 4-12 Automatically Load DEM 

  
Hazus will load the file paths for all the DEM files into the User Data window (Figure 4-13). Click OK 
to complete importing the DEM files. Click Yes (not shown) on the next popup window to proceed 
with DEM analysis.  

 

Figure 4-13 Import DEM Files into Hazus 
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A progress bar (Figure 4-14) will appear as Hazus imports and merges all the individual files into a 
single DEM for the Study Region. This may take several minutes depending on the size of the Study 
Region. A notification (Figure 4-15) will appear once the DEM import is completed. Click OK. 

 

Figure 4-14 DEM Import Progress 

 

 

Figure 4-15 DEM Import Completed 

 
The Hazus Flood Model mapping should look like Figure 4-16 after the DEM import. 
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Figure 4-16 Example – Flood Model after DEM Import 

 
To create the stream network, open the Hazard drop-down menu and select Develop Stream 
Network (Figure 4-17). 

 

Figure 4-17 Select Develop Stream Network in Hazard Menu 

  
The Develop Stream Network window (Figure 4-18) will appear. Use the default value of 10.0 square 
miles that appears in the drainage area field and click OK. Click Yes (not shown) on the next popup 
window to proceed with developing the stream network. 
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Figure 4-18 Enter Drainage Area for Develop Stream Network 

  
A progress bar (Figure 4-19) will appear as Hazus performs the GIS analysis to develop the stream 
network. This may take several minutes to an hour depending on the size of the Study Region. A 
notification (Figure 4-20) will appear once the stream network has been completed. Click OK. 

 

Figure 4-19 Develop Stream Network Progress 

 

 

Figure 4-20 Develop Stream Network Completed 

 
The Hazus Flood Model mapping should look like Figure 4-21 after developing the stream network. 
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Figure 4-21 Example – Flood Model after Developing Stream Network 

  
To create a scenario within the Flood Model, open the Hazard drop-down menu and select Scenario 
and New (Figure 4-22). 

 

Figure 4-22 Select Scenario and New in Hazard Menu 
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The Create New Scenario window (Figure 4-23) will appear. Enter a unique name for the scenario 
and a brief description. Click OK.  

 

Figure 4-23 Provide Name for New Scenario 

  
The New Scenario window (Figure 4-24) will appear. To select the streams to add to the scenario 
from the Flood Model mapping, click the + button to the right of Add to selection. This will activate 
the screen cursor on the mapping screen in ArcMap, which allows the user to select all the streams 
in the region. 
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Figure 4-24 Select Add to Selection for River Reaches 

  
Once the streams have been selected, the Flood Model will show the streams in a different color as 
shown in Figure 4-25. 
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Figure 4-25 Example – Flood Model after Stream Selection 

  
To complete the stream selection, go back to the New Scenario window and click on the button with 
the disk graphic to the right of Save selection (Figure 4-26). The OK button will become active. Click 
OK to complete the stream selection. 



Hazus Flood Model User Guidance 

 Page 4-16 

 

Figure 4-26 Select Save Selection to Finalize Selected River Reaches 

  
If the stream selection was performed correctly, the Flood Model should look like Figure 4-27. All 
selected streams are saved to a new data layer called Chosen Reaches and are shown in red. 
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Figure 4-27 Example – Flood Model after Stream Reaches Chosen for a Scenario 

  
To conduct the hydrologic analysis, open the Hazard drop-down menu and select Hydrology 
(Figure 4-28). 

 

Figure 4-28 Select Riverine and Hydrology in Hazard Menu 

  
A notification window (Figure 4-29) will warn the user that raster processing cannot be canceled. 
Click Yes.  
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A progress bar (Figure 4-30) will appear as Hazus performs the hydrologic analysis. This may take 
several minutes to several hours depending on the size of the Study Region and the number of 
selected streams. A notification (Figure 4-31) will appear once the hydrologic analysis has been 
completed. Click OK. 

 

Figure 4-29 Select Yes to Start Hydrologic Analysis 

  

 

Figure 4-30 Hydrologic Analysis Progress 

 

 

Figure 4-31 Hydrologic Analysis Completed 

 
If the hydrologic analysis was performed correctly, the Flood Model should look like Figure 4-32.  
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Figure 4-32 Example – Flood Model after Hydrologic Analysis 

 
To conduct the floodplain analysis, open the Hazard drop-down menu and select Delineate 
Floodplain (Figure 4-33). 

 

Figure 4-33 Select Riverine and Delineate Floodplain in Hazard Menu  
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The Riverine Hydraulic Analysis window (Figure 4-34) will open. Select Single Return Period for 
Analysis type. Keep the default Output cell size. Finally, for each stream keep the default return 
period of 100 years and the default Manning’s roughness coefficient n-value shown in the third 
column of the table. Click OK. 

 

Figure 4-34 Delineate Floodplain for a Single Return Period  

  
A progress bar (Figure 4-35) will appear as Hazus performs the hydraulic analysis needed to 
delineate the floodplain for each selected stream. This may take several minutes to several hours 
depending on the size of the Study Region and the number of selected streams. A notification 
(Figure 4-36) will appear once the floodplain analysis has been completed. Click OK. 
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Figure 4-35 Delineate Floodplain Progress 

 

 

Figure 4-36 Delineate Floodplain Completed 

  
If the floodplain analysis was performed correctly, the Flood Model should look like Figure 4-37. 
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Figure 4-37 Example – Flood Model after Delineate Floodplain 

  
Begin computing losses within the Study Region’s newly delineated floodplains by opening the 
Analysis drop-down menu and selecting Run (Figure 4-38). 

 

Figure 4-38 Select Run in Analysis Menu 
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The Analysis Options window (Figure 4-39) will open. Click the + button to the left of General Building 
Stock Damage and Loss to expand and view the loss category. Next, click the small open box to the 
left of General Building Stock Damage and Loss so that all subcategories are also selected. Click OK. 

 

Figure 4-39 Select General Building Stock Damage and Loss from Analysis Options 

  
A progress bar (Figure 4-40) will appear as Hazus calculates flood losses. This may take several 
minutes to several hours depending on the size of the Study Region. A notification (Figure 4-41) will 
appear once floodplain losses have been completed. Click OK. 
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Figure 4-40 Flood Losses Progress 

 

 

Figure 4-41 Flood Losses Completed 

  
At this point, the user will have successfully created a Study Region, delineated streams and 
floodplains, and calculated losses. For more information on displaying, understanding, and exporting 
loss results, see Section 8. 
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Section 5. Model Menu: Inventory 
The Inventory menu, shown in Figure 5-1, has inventory types and subtypes that allow the estimation 
of the amount of exposure and potential damage in the Study Region. Inventory data include basic 
information on population, buildings, and facilities obtained from the United States Census and other 
national sources. These data can be supplemented with additional user-supplied datasets. The 
screenshots in this section show all of the options for the Inventory menu. 

 

Figure 5-1 Inventory Menu  

5.1 General Building Stock 
The first type of inventory is General Building Stock. The subtypes are Square Footage, Building 
Count, Valuation Parameters, Dollar Exposure, Depreciation Parameters, Depreciated Exposure, 
General Occupancy Mapping, and Flood Specific Occupancy Mapping, as shown in Figure 5-2. First 
Floor Elevations is temporarily disabled. 

 

Figure 5-2 Inventory > General Building Stock Menu   
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5.1.1 Square Footage 
Square Footage, opened through the menu shown in Figure 5-2, allows the user to view the type of 
square footage distribution per the Census block, as shown in Figure 5-3. 

 

Figure 5-3 Square Footage Table 

5.1.2 Building Count 
Building Count allows the user to review the building count per Census block By Occupancy and By 
Building Type for specific and general occupancies, as shown in Figure 5-4. The user can view and 
modify the building count values by only specific occupancy for each Census block. 
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Figure 5-4 Building Count (by Occupancy) Table 

5.1.3 Valuation Parameters 
Valuation Parameters allow the user to review the replacement costs for each occupancy type, as 
shown in Figure 5-5. Clicking the Next button on each window will take the user through the following 
information windows:  

1. Replacement Cost (based on a specific year) 

2. Location Factors 

3. Single-Family (RES1) Garage Distributions by Census Block 

4. Single-Family (RES1) Garage Replacement Cost  

5. Single-Family (RES1) Basement Distribution by Census Block 

6. Height Distribution (Number of Stories) by Census Block 
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Figure 5-5 Valuation Parameters Table 

5.1.4 Dollar Exposure (Replacement Value): 
Dollar Exposure (Figure 5-6) allows the user to review the exposure per Census block By Occupancy 
and By Building Type. The user can view and modify the exposure values by only specific occupancy 
for each Census block. 
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Figure 5-6 Dollar Exposure Table 

5.1.5 Depreciation Parameters 
Depreciation Parameters (Figure 5-7) allow the user to review the median year built and median age 
of buildings in each Census block. 
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Figure 5-7 Depreciation Parameters Table 

5.1.6 Depreciated Exposure 
Depreciated Exposure (Figure 5-8) allows the user to review the depreciated exposure By Occupancy 
or By Building Type. This data is calculated based on the median building age and a depreciation 
curve. The user can view and modify the building depreciated values by only specific occupancy for 
each Census block. 
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Figure 5-8 Depreciated Exposure Table 

5.1.7 General Occupancy Mapping 
The General Occupancy Mapping window (Figure 5-9) allows the user to view, copy, edit, and delete 
the distribution of general building types in the Study Region. By default, the specific state 
distribution is the only scheme available. This data can be viewed and copied but cannot be edited 
or deleted. The user can make a copy of the baseline data (by selecting the baseline data and 
clicking Copy and entering a new scheme name and description) and edit this data (by clicking the 
new copy and clicking Edit).  
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Figure 5-9 General Occupancy Mapping Schemes 

5.1.8 Flood Specific Occupancy Mapping 
Flood Specific Occupancy Mapping (Figure 5-10) allows the user to view the default assumptions for 
physical building characteristics of structures in any specific occupancy category. There are three 
default mapping schemes (Coastal, Great Lakes, and Riverine). All three schemes can be copied, 
and the copy versions can be edited to create custom schemes.  

For example, to view the Pre- and Post-FIRM (Flood Insurance Rate Map) distributions of foundation 
types for all RES1 buildings, select a Mapping Scheme and click View. Figure 5-11 shows the Flood 
Building Characteristics Distribution window that will appear. Users can create custom schemes by 
clicking the Copy button, which activates the Edit button. Click Edit to change percentage values in 
the copy.  
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Figure 5-10 Flood-Specific Occupancy Mapping Schemes 
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Figure 5-11 Flood Building Characteristics Distribution 

5.1.9 First Floor Elevations Flood-Specific Occupancy Mapping 
The First Floor Elevations window (Figure 5-12) allows the user to view the default assumptions for 
first floor heights of various foundation types. Editing functionality was temporarily disabled. The 
original process required user-defined first floor heights to be assigned by clicking on the User-
defined tab and selecting the Use user-defined values check box, then editing the first-floor height 
values for the foundation types and clicking OK. If this functionality is not working, users can contact 
the Hazus Help Desk for guidance on using SQL Management Studio to view or modify Finished Floor 
Elevations. 
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Figure 5-12 First Floor Elevations 

5.2 Essential Facilities 
Selecting Essential Facilities from the Inventory menu (Figure 5-13) will display the Essential 
Facilities Inventory table (Figure 5-14), which allows the user to view and map the locations and 
characteristics of medical care facilities, emergency centers, and schools. 
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Figure 5-13 Inventory / Essential Facilities Menu 

 

 

Figure 5-14 Essential Facilities (Medical Care Facilities) Table 
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5.3 User-Defined Facilities 
Selecting User-Defined Facilities from the Inventory menu (Figure 5-15) will display the User-Defined 
Facilities table (Figure 5-16), which allows the user to view and map the locations and characteristics 
of any facilities that have been imported by the user.  

 

Figure 5-15 Inventory / User-Defined Facilities Menu 

 

 

Figure 5-16 User-Defined Facilities Table 
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5.4 Transportation Systems 
Selecting Transportation Systems from the Inventory menu (Figure 5-17) will display the 
Transportation Systems Inventory Data table (Figure 5-18), which allows the user to view and map 
the location and characteristics of highways, railways light rails, buses, ports, ferries, and airports. 

 

Figure 5-17 Inventory > Transportation Systems Menu 

 

 

Figure 5-18 Transportation Systems Table 
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5.5 Utility Systems 
Selecting Utility Systems from the Inventory menu (Figure 5-19) will display the Utility Systems 
Inventory table (Figure 5-20), which allows the user to view and map the locations and 
characteristics of facilities for potable water, wastewater, oil, natural gas, electric power, and 
communications. 

 

Figure 5-19 Inventory / Utility Systems Menu 

 

 

Figure 5-20 Utility Systems Table 
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5.6 Demographics 
Selecting Demographics from the Inventory menu (Figure 5-21) will display the Demographics table 
(Figure 5-22), which allows the user to view and map categorical Census data aggregated by Census 
block. 

 

Figure 5-21 Inventory / Demographics Menu 

 

 

Figure 5-22 Demographics Table 
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5.7 Vehicles 
Selecting Vehicles from the Inventory menu (Figure 5-23) will display the Vehicles table (Figure 5-24), 
which shows two tabs with information about vehicle count and dollar exposure by Census block. The 
table can be changed to show daytime or nighttime values using the Day / Night drop-down. These 
values are estimated based primarily on the building occupancies in each Census block. 

 

Figure 5-23 Inventory / Vehicles Menu 

 

 

Figure 5-24 Vehicles (Vehicle Count) Table 
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5.8 View Classifications 
View Classifications (Figure 5-25) allows users to view definitions of the classification categories. The 
subtypes are General Building Stock, Essential Facilities, High Potential Loss Facilities, 
Transportation Systems, and Utility Systems, as shown in Figure 5-25. 

 

Figure 5-25 Inventory / View Classifications Menu 

5.8.1 General Building Stock Classifications 
The Buildings Classifications table (Figure 5-26) allows the user to view the assumptions used to 
define values for Building Occupancy Classes and Model Building Types. 
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Figure 5-26 Buildings Classifications Table 

5.8.2 Essential Facilities Classification 
The Essential Facilities Classifications table (Figure 5-27) allows the user to view the assumptions 
used to define values for Medical Care Facilities, Emergency Centers, and Schools. 
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Figure 5-27 Essential Facilities Classification Table 

5.8.3 Transportation Systems Classification 
The Transportation Systems Classification table (Figure 5-28) allows the user to view the 
assumptions used to define values for Highway, Railway, Light Rail, Bus, Port, Ferry, and Airport. 

 



Hazus Flood Model User Guidance 

 Page 5-21 

 

Figure 5-28 Transportation Systems Classification Table 

5.8.4 Utility Classifications 
The Utility Classifications table (Figure 5-29) allows the user to view the assumptions used to define 
values for Potable Water, Wastewater, Oil, Natural Gas, Electric Power, and Communications.  
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Figure 5-29 Utility Classifications Table 
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Section 6. Model Menu: Hazard  
The Hazard menu (Figure 6-1) within Hazus has several analysis types from which to choose. These 
options enable the user to select the appropriate analysis to perform on the Study Region. This 
section explains the selections and the inputs required for each.  

 

Figure 6-1 Hazard Menu  

6.1 Flood Hazard Type 
The riverine and coastal hazards have different requirements for developing the hazard and the 
digital elevation data required to support the analysis.  

The first option on the Hazard menu (Figure 6-2) is Flood Hazard Type. Selecting this option activates 
the Flood Hazard Type dialog shown in Figure 6-3. In this dialog, the user selects the Study Region’s 
flood hazard type for analysis. The Storm  surge option is only enabled if the user is conducting a 
combined Hurricane and Flood hazard analysis and previously ran the Hurricane model.  

The Flood Hazard Type selection on the Hazard menu (Figure 6-2) prevents users from having to 
supply unnecessary digital terrain data for the selected hazard type and enables only those menu 
items that are needed to support the hazard.  

 

Figure 6-2 Select Flood Hazard Type  
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Figure 6-3 Flood Hazard Type Dialog 

Users should think carefully about which hazard type (or both) they are interested in analyzing, as the 
selection will drive the entire hazard assessment. Changing the Flood Hazard Type selection will 
change the DEM requirements and prevent the user from accessing some of the menu items not 
applicable for that flood hazard type. For example, selection of the Riverine only button will require a 
DEM that covers both the Study Region and all the watersheds that intersect that Study Region and 
will require the user to develop a stream network, creating a Scenario (described later in this 
section). A coastal analysis does not require a stream network or hydrologic analysis but does 
require a DEM for the coastal area of the Study Region.  

6.2 User Data 
The User Data selection from the Hazard menu (Figure 6-4) activates the window shown in Figure 
6-5. Here, the user can select the appropriate tab to import the relevant data for the analysis. The 
User Data window offers four data import options: DEM, Depth Grid, and HEC-RAS. This section will 
provide details on using the DEM import option, while Section 12 provides more details on the other 
two options. Note: the FIT Tool has been deprecated as of Hazus 5.0, however, users with existing 
FIT data may still import FIT folders using the FIT tab. 

 

Figure 6-4 Select User Data  
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Figure 6-5 User Data Options Window 

Click Determine required DEM extent shown in Figure 6-5 to have the Flood Model determine the 
DEM files required for the analysis. The extent will be different for riverine versus coastal flood 
analysis. 

After a short pause, the DEM Extent window will appear, as shown in Figure 6-6. This window lists the 
required latitude and longitude coordinates that are needed to download the U.S. Geological Survey 
(USGS) DEM data. The latitude and longitude shown may extend beyond the defined boundaries of 
the Study Region because the watersheds that affect the region’s flood risk probably extend outside 
the political boundaries. 

Note that any DEM imported into the Flood Model must meet the bounding coordinate constraints 
established by this dialog. The Model will discontinue processing if it identifies gaps in the data 
coverage.  
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Figure 6-6 DEM Extent Window  

Use the Select NED Resolution drop-down menu to choose the desired resolution. The default is 1 
Arc-Second (~30 meters). Not all Study Regions will have available USGS DEM data for resolutions 
other than 1 Arc-Second. For example, choosing 1/3rd Arc-Second for a Study Region in Montgomery 
County, VA, will refresh the table and warn the user, “Problem downloading DEM” 

6.2.1 Automated DEM Download 
Click Download required DEM in the DEM Extent window shown in Figure 6-6 for Hazus to obtain all 
the required DEM files and save them within the Hazus Study Region folder.  

Hazus will take several minutes to download all of the DEM files. When the process has completed, a 
notification window will appear (Figure 6-7) to indicate the files have been downloaded and saved. 
Click OK. 
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Figure 6-7 DEM Downloaded, Unzipped, and Saved 

  
A popup window (Figure 6-8) will ask the user whether to automatically load the DEM data into the 
User Data window. Click Yes.  

 
Figure 6-8 Automatically Load DEM  

  
Hazus will load the file paths for all of the DEM files into the User Data window (Figure 6-9).  
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Figure 6-9 Import DEM Files into Hazus 

  
Click OK to complete importing the DEM files. Click Yes (not shown) on the next popup window to 
proceed with DEM analysis.  

A progress bar (Figure 6-10) will appear as Hazus imports and merges all the individual files into a 
single DEM for the Study Region. This may take several minutes depending on the size of the Study 
Region. A notification (Figure 6-11) will appear once the DEM import is completed. Click OK. 
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Figure 6-10 DEM Import Progress 

 

  

Figure 6-11 DEM Import Completed 
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6.3 Develop Stream Network 
If the Study Region is subject to riverine flood hazard, the next step is to generate a stream network. 
This is not required if the user is only running scenarios with the recommended user-supplied flood 
hazard data (depth grids or HEC-RAS floating-point binary [.FLT] grids). Generating a stream network 
is a one-time analysis that establishes the river network identity for all subsequent scenarios. 

The Develop Stream Network selection on the Hazus menu (Figure 6-19) activates the Develop 
Stream Network dialog shown in Figure 6-20. Enter the number of square miles that define the 
stream drainage area for the Study Region. 

 

Figure 6-12 Select Develop Stream Network  

 

 

Figure 6-13 Develop Stream Network Dialog 

 
The model will process the DEM for the Study Region to determine the locations of streams. This 
analysis will take some time, ranging from 5 minutes to several hours, depending on the computer’s 
processing speed, the size of the Study Region, and the complexity of the DEM. When the process is 
complete, the identified streams will appear on the Study Region, like Figure 6-21. 
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 Selecting a small number of square miles, such as 1, for the drainage area will result in a highly 
defined stream network. This value represents the total land area, in square miles, that drains 
into any given reach, excluding that drainage at the starting node of the reach (the downstream 
node from the prior reach). The smaller the drainage area, the more processing time required by 
the Flood Model for subsequent analyses. 

 

Figure 6-14 Example – Flood Model after Developing Stream Network 

 Running the stream network, the first time, is fairly time consuming as the model performs an 
analysis to fill in spurious sinks in the DEM. However, to save the user time for subsequent runs, 
the model saves the results of the sink-filling process. As such, if the user decides to change the 
drainage area number, the model will not require nearly as much time to perform the analysis. 
For example, if the user runs the stream network at 5 square miles and then decides that the 
network requires more detail, changing the drainage area to 1 square mile will process 
significantly faster than the original analysis. Please note that Hazus must still re-calculate and 
assign the Manning’s-n coefficient, associated with stream roughness, to each reach. This 
process will appear to the user as “Finalizing Stream Network” and will take additional 
processing time if the user changes the drainage area value. 

If a river in the analysis forms a border between two counties, including both counties on either side 
of the river in the Study Region is recommended. The stream network in Hazus is known as a 
synthetic network because it is derived entirely from the DEM. No imagery or pre-existing map layers 
are used in its generation. More specifically, streams in a synthetic network exist at DEM grid cell 
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locations that receive drainage from a threshold number of upstream grid cells. If the DEM is not 
large enough, the threshold number of grid cells may not be reached.  

Figure 6-22 shows an example of this situation with a discontinuous synthetic stream. The Study 
Region consists of one county, for which the one river (displayed in red) forms a border. Because the 
DEM does not include areas draining to both sides of the river, the resulting synthetic stream is 
discontinuous. There are simply not enough DEM grid cells draining to the discontinuous portions to 
properly delineate them. 

 

Figure 6-15 Example Discontinuous Synthetic Stream 

The solution to this discontinuity problem is to include counties on both sides of the river during 
Study Region creation. Including both counties will result in a larger DEM that drains to both sides of 
the river. Figure 6-23 illustrates this concept using the same stream as shown in Figure 6-22. The 
second Study Region consists of counties on either side of the river (shown in red) and the resulting 
synthetic stream network is now continuous. 

 

Figure 6-16 Example Continuous Synthetic Stream 
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6.4 Scenario 
A scenario defines the specific stream reaches, or lengths of coastline for coastal users, and the 
hydrologic and hydraulic characteristics to be included in one analysis run. A scenario could include 
all stream reaches in the Study Region, and/or the coastline in a coastal Study Region. However, 
because the analysis requires significant computer processing, dividing the region into several 
smaller scenarios may be preferable. Figure 6-24 shows the Hazard > Scenario menu with only the 
New selection active prior to defining the first scenario for a Study Region. Figure 6-25 shows the 
Hazard > Scenario menu with all selections active after the initial scenario has been defined. 

 

Figure 6-17 Select New Scenario (Prior to Defining First Scenario)  

6.4.1 New 
Under the Scenario menu option, select New, as shown in Figure 6-25, to create a new scenario. The 
process of defining a new scenario for riverine, coastal, and combined analyses each require 
different steps. These steps are detailed in the next sections. 

 

Figure 6-18 Select New Scenario (After Defining First Scenario)   
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6.4.1.1 Riverine Scenario 
The Create New Scenario window, shown in Figure 6-26, will appear. Enter a name for the scenario 
and an optional description. Be careful not to include any leading or trailing spaces. The Description 
will be visible to the user when opening scenarios in the future to help differentiate between similarly 
named scenarios.  

 

Figure 6-19 Enter a Name for the New Scenario 

 
After naming the scenario, the New Scenario window (Figure 6-27) will open, allowing the user to 
select which stream reaches to include in the scenario. Click the radio button next to the appropriate 
Map layer type. To select features, click the Add to selection ( + ) button, then drag the selection box 
around the features to be selected to add reaches to the scenario and then click Save selection (the 
floppy disk icon). The Remove from selection ( − ) button removes reaches from the selected 
reaches. Similarly, the Clear selection (  ) button clears all reaches from the selection. 

The selected features will be highlighted in a light blue color, as shown in Figure 6-28. After saving 
the selected stream reaches, click OK to complete the definition of the scenario. The color of the 
selected reaches changes from light blue to red when this process is complete. 
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Figure 6-20 Select Map Features 

 

 

Figure 6-21 Select River Reaches for a Scenario 
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 After selecting the features in the map layer, users must click Save selection for each specific 
map layer type. For example, if a user wants to create a scenario with river reaches and coastal 
shorelines, the user must: 1. Select the River reaches radio button, click the Add to selection 
button, select reach(es), click the Save selection button. 2. Select the Coastal shorelines radio 
button, click the Add to selection button, select shoreline(s), click the Save selection button.  
Click OK.  

If the user has imported any flood depth grid(s), those areas can be selected by clicking on the User-
defined depth grids radio buttons. Note, Hazus provides an option to import data from the Hazus FIT 
tool, however FIT is no longer supported. Select and save FIT areas and/or flood depth grids in the 
same manner as the reach selection if necessary, however it is considered a best practice to use 
user-supplied depth grids. 

If more than one flood depth grid is selected for the scenario, the dialog will expand to show the list 
of selected flood depth grids selections, as shown in Figure 6-29. Users can select one or more 
depth grids for the scenario. 

  

Figure 6-22 Select User-Defined Depth Grids for a Scenario 
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6.4.1.2 Coastal Scenario 
The coastal analysis does not require the user to generate a stream network or run the hydrologic 
analysis. However, the user will still be required to obtain and identify the DEM to be used in the 
analysis. The extent of the DEM necessary for the coastal flood hazard is different from that required 
for the riverine flood hazard. The necessary DEM is determined by the union of the region shoreline 
with the Study Region boundary. 

Once the DEM has been added, the user can move directly to defining a scenario by selecting New 
from the Hazard > Scenario menu. The Create New Scenario window will appear (Figure 6-30). As 
with the riverine analysis, enter a name and, if desired, a description for the scenario, and click OK. 
The window shown in Figure 6-31 will appear.  

  

Figure 6-23 Enter a New Scenario (Coastal) 
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Figure 6-24 Select a Shoreline for a New Coastal Scenario 

 
Like the riverine hazard, the user will be asked to select a shoreline or shorelines for analysis (Figure 
6-31). Click the radio button next to the appropriate Map layer type (Figure 6-32). The Flood Model 
uses a standard GIS selection tool to allow the user to select the shorelines. Click the Add to 
selection ( + ) button, then either click on the shoreline or draw a box to select more than one 
shoreline. Note that although the shoreline is simplified, selecting small island areas off the main 
coast can produce island transects that interfere with the main coastal segment. They should be 
analyzed separately or left out of the analysis. 
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Figure 6-25 Select Shoreline 

 
 To select discontinuous shorelines, such as islands, press the Shift key while selecting additional 

shorelines. To deselect shorelines, press the Shift key and click on the shorelines that are not to 
be included in the selected shorelines. 

 Hazus has a built-in default national shoreline that is delineated by county. In Study Regions that 
are sub-county or a combination of multiple sub-counties, all the associated shorelines of the 
counties will be brought in. This is by design to account for coastal flooding at specific locations 
that does not necessarily originate from the closest shorelines to those locations.   

 The Flood Model has shorelines for mainland areas, barrier islands, large islands, small islands, 
and the Great Lakes. These shorelines have been smoothed to allow the Flood Model to build 
shore normal transects in a less time-consuming fashion. 

Once the shorelines have been selected, click the Save Selection button (the floppy disk icon); the 
OK button will become enabled (Figure 6-32). Click OK. This completes the process of creating the 
new scenario and selecting shorelines. The next step in the process is to characterize the chosen 
shorelines. 
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The Shoreline Limits dialog (Figure 6-33) will automatically pop up after shorelines are selected for 
the scenario to characterize the limits of the shoreline. This dialog begins the process in which the 
user identifies where they wish to start characterizing the shoreline (Shoreline Start) and where they 
would like to finish the characterization (Shoreline End) as shown on the interactive map layer 
(Figure 6-34). In between these two points, the user will want to add any breaks in the shoreline 
(Breaklines) where the geographic characteristics of the shoreline change. The Flood Model will 
develop transects at 1,000-foot increments and perform the analysis (e.g., simplified Wave Height 
Analysis for Flood Insurance Studies [WHAFIS]) only between the Shoreline Start and Shoreline End 
lines. If the default locations (at the end of each segment) are moved, the Flood Model will limit the 
development of transects between these locations.  

 The Flood Model will develop transects and perform a simplified WHAFIS and runup analysis 
between the Shoreline Start and Shoreline End lines—either the default locations or those 
generated by the user. The Flood Model will still develop a stillwater elevation (SWEL) surface 
over the entire Study Region to ensure that flooding through other low-lying areas is properly 
accounted for. 

The Shoreline Limits dialog allows the user to perform the segmentation of the shoreline if necessary 
(Figure 6-33). Figure 6-34 shows the interactive map layer. 

 

Figure 6-26 Input Shoreline Limits  
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Figure 6-27 Example – Setting Shoreline Limits 

 
The user can leave the shoreline start and end as shown in Figure 6-34 or change the limit(s) 
(Startline or Endline) and click the Draw button (circled) to draw a new line on the map. The model 
will remove the default line and replace it with the newly drawn line. For example, Figure 6-35 shows 
what the user might see upon changing the Shoreline Start point (Startline). 

 The user must be sure to draw the line so that it crosses the shoreline only once. This could be 
from inland into the flood source or from the flood source inland. The Flood Model will 
automatically make the line shore normal or perpendicular to the shoreline. 

 Hazus allows users to zoom in or out of the map before clicking on the Draw button. After clicking 
the Draw button, the tool is set to the Line tool, and the customization becomes locked; 
therefore, users will not be able to select any other tool until the Startline, Endline, and 
Breakline(s) are drawn. 

 The user can move the Startline if the initial effort is not in the right location by merely 
reselecting the Draw button and drawing the Startline in another location. Similarly, if the user 
decides not to change the Startline after having drawn one, the user can click on the Use Default 
button and restore the Startline to its default location. 

 Clicking on the Use Default button (see Figure 6-35) will only restore the active Limit type, such 
as the Startline or the Endline. To restore both the Startline and the Endline, the user needs to 
select the appropriate radio button and click on the Use Default button for each line. 
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Figure 6-28 Example – Resetting the Shoreline Startline 

 
Figure 6-36 shows an example of a changed Shoreline End (Endline). Like the Startline, the user can 
change the location of the Endline by clicking on the Draw button and drawing a new line. To restore 
the Endline to its default location, click on the Use Default button with the Endline radio button 
enabled. 

 

Figure 6-29 Example – Resetting the Shoreline Endline 
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As stated previously, if the Study Region geography changes along the shoreline, the user will want to 
segment the shoreline and classify the shoreline into the proper geophysical properties. Consult a 
Flood Insurance Study (FIS), identify the areas along the shoreline where the SWEL changes, and 
create a Breakline at these points. Select the Breakline radio button and click Draw. As with the 
Startline and the Endline drawing, draw a line crossing the shoreline only once, as circled in Figure 
6-37.  

 

Figure 6-30 Example – Adding a Breakline to the Selected Shoreline 

 
 The user cannot change or move a Breakline once it has been drawn; to remove the line, clear 

the Breakline using the Clear All button and redraw the Breakline in the new location. 

After all breaklines have been drawn, click Next to open the Shoreline Characteristics window shown 
in Figure 6-38. The information for this window can be obtained from a FEMA FIS. Check the FEMA 
website for information on obtaining an effective FIS for the Study Region.  

Input the SWEL in the Elevation field shown in the Shoreline Characteristics window (Figure 6-38). 
This field and the Vertical Datum field are required and will be shown in red text. The Hazus default 
vertical datum is NGVD29, however, users should be aware that NAVD88 is more commonly 
associated with the SWEL for recent FEMA studies. The other SWEL fields are loaded with default 
parameters calculated using the standard FEMA ratios but can be edited and overwritten by the user 
if the data are available from the FIS. 

 The user should review the FIS carefully to determine whether the 100-year SWEL includes wave 
setup. If it does, the user should put in the 100-year SWEL as noted in the FIS but must also 
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check the Yes radio button under the Elevation includes wave setup? question. Doing this will 
enable the Wave Setup (ft) field. The user should enter the wave setup value here. If the user 
cannot identify whether wave setup is included, quickly graph the SWELs listed in the FIS and 
check whether the 100-year SWEL is higher than expected by the graph. If so, it most likely 
includes wave setup. 

 Users should select a wave exposure for each segment corresponding to its fetch under 100-year 
flood conditions, not under normal conditions. For example, a mainland shoreline segment, 
landward of a low-lying island, may have a short fetch under normal conditions, but the island may 
be flooded, and the fetch may increase under more severe conditions. 

After entering the Elevation and Vertical Datum for each shoreline segment, click Finish. 

  

Figure 6-31 Shoreline Characterization – Stillwater Flood Conditions Window 

 
Once the user has completed inputting the required information in the Shoreline Characteristics 
window, the Flood Model has the necessary data to perform a coastal analysis for any given return 
interval. 
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6.4.1.3 Combined Riverine and Coastal Scenario 
Hazus asks the user to select between three flood hazard types in the Flood Hazard Type dialog 
(Figure 6-3) to limit the DEM requirements: Riverine Only, Coastal Only, or Riverine and Coastal. 
Selecting Riverine and Coastal will require the user to acquire a DEM that supports the analysis for 
both hazard types. Once the user provides the DEM, they can perform any of the hazard analyses.  

For example, if the user selects Riverine and Coastal, they are required to build the Stream Network 
with the shorelines already available. While creating a scenario, the user has the option to build a 
scenario with only river reaches, only shorelines, or a combination of reaches and shorelines. The 
Flood Model maintains the riverine and the coastal hazard depth grids separately because the depth 
of flooding alone does not determine which hazard is producing the most damage by occupancy. 

Create a riverine and coastal flood hazard analysis within the Study Region. If necessary, first create 
a new Study Region. Once the Study Region is created, open it, open the Hazard drop-down menu, 
and select Flood Hazard Type. Choose the Riverine and Coastal flood hazard type (Figure 6-3). See 
Section 3 to review how to create a flood Study Region and Section 4 for details on opening a Study 
Region. 

If the user chooses to run a scenario with river reaches and coastal shorelines, the Flood Model will 
analyze the impact of both hazards on the inventory independently. It will then compare the resulting 
losses to determine which hazard is the controlling hazard (i.e., the hazard that has the greatest 
impact on that occupancy or structure). 

To perform a combined analysis, the user would create a new scenario with both riverine and coastal 
components. After the Create New Scenario window (not shown), select the River reaches radio 
button (Figure 6-39). Then, select reach(es) using the Add to selection ( + ) button, and click Save 
selection. Second, select the Coastal shorelines radio button (Figure 6-39). Then, select shoreline(s) 
using the Add to selection button, and click Save selection. Click OK to ensure that both selected 
layers are saved. For more detailed instructions, refer to the previous sections on creating Riverine 
and Coastal Scenarios separately.  
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Figure 6-32 Select River Reaches and Coastal Shorelines 

6.4.2 Open 
A user may create multiple scenarios for each Study Region. Select Open from the Scenario menu, 
as shown in Figure 6-40, to open a previously created scenario. The Open Scenario dialog will appear 
(Figure 6-41). Click on the scenario’s name to highlight it, and then click OK. Only one scenario can 
be opened at a time.  

 

Figure 6-33 Select Open Scenario  
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Figure 6-34 Open Scenario Dialog 

6.4.3 Save As  
The Save As option under the Scenario menu allows users to skip the hazard analysis every time 
they want to run different parameters in the Inventory or Analysis menu. It saves the user time by 
skipping the hazard selection and rerunning the analysis. It also provides the user a way to preserve 
previous results without using the Duplicate Study Region function, which requires much more disk 
space. The results tables are scenario-specific and creating a new scenario using the Save As 
function assumes the user wants new results. As such, the old results are not carried over. 

In addition to creating a new scenario and opening a scenario, the Scenario menu options shown in 
Figure 6-42 let the user edit, close, or delete any created scenarios. To use the Save As capability, 
the scenario to be saved must be open. From the Scenario menu, select Save As. The Save Scenario 
As window, shown in Figure 6-43, will appear. Enter a name for the new scenario and an optional 
description. Click OK to save the old scenario and automatically open the new scenario.  

NOTE: Each scenario must have a unique name.  
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Figure 6-35 Select Save As  

 

 

Figure 6-36 Enter a New Name for the Scenario  

 
 When a user modifies the inventory, all future results are affected as future analyses will use the 

updated inventory. If the inventory is modified, the analysis should be rerun. Users that plan on 
modifying the inventory should “duplicate” the Study Region to compare results, otherwise the 
results are overwritten. The results will be overwritten if and only if the user reruns the analysis 
on the same scenario. 
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Users that plan to modify the functions/parameters in the Damage and Loss Estimate analysis 
should use the Save As capability to compare results between scenarios, otherwise they are 
overwritten. The changes to damage functions are per Study Region, so the user is responsible for 
knowing which damage functions were used to create the results of which scenario. The user will not 
be able to display which damage functions were used for each scenario.  

Users that plan to modify the hazard analysis do not need to use the Save As capability. However, a 
few cases must be taken into consideration: 

Mix grid: Mix grids are created when Hazus does not know what return period to assign to the grid, 
such as the case of running a specific discharge analysis or assigning different return periods to 
different reaches in a single scenario. If a user is dealing with a mix grid case and reruns the hazard 
by changing some parameters (return period of one or more reaches, or the discharges), the 
changes to the depth grid and floodplain polygon due to this rerun will not be reflected in the loss 
analysis results until the loss analysis is rerun.  

Edits to scenario: If a user reruns the hazard by adding or subtracting at least one reach from the 
scenario but uses the same return period, the user should rerun the loss analysis so that the results 
reflect the changes to the hazard.  

User Depth Grids and HEC-RAS .FLT Depth Grids: Inside the Flood Model, the only option available to 
the user in terms of modifying User Depth Grid/.FLT Depth Grid results is to choose which User 
Depth Grid/.FLT Depth Grid polygons to include in the scenario. If that kind of modification is made 
to the hazard, the user should rerun the flood delineation analysis so that the results reflect the 
changes to the hazard.  

In all three cases, if the user reruns the analysis without using the Save As capability, the previous 
results will be lost. 

6.4.4 Edit 
The Edit option under the Scenario menu, shown in Figure 6-44, allows users to add/remove reaches 
to the scenario. If a user has not selected the correct reaches or shoreline, the Edit option allows the 
user to go in and re-select the correct reaches or shoreline. 



Hazus Flood Model User Guidance 

 Page 6-28 

 

Figure 6-37 Select Edit  

6.4.5 Close 
The Close option under the Scenario menu, shown in Figure 6-45, closes the scenario in the mxd. 
The scenario is not deleted but will not be the active scenario for any changes or updates. 

 

Figure 6-38 Select Close 

6.4.6 Delete 
The Delete option under the Scenario menu, shown in Figure 6-46, allows users to delete scenarios 
that are no longer needed. The Delete option allows users to delete multiple scenarios all at once by 
clicking on the scenarios. To use the Delete capability, the scenario to be deleted must be closed. 
Select Delete from the Scenario menu. The Delete Scenario dialog will appear (Figure 6-47). Select 
the scenario(s) to be deleted and click OK. 
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Figure 6-39 Select Delete  

 

 

Figure 6-40 Delete Scenario Dialog 
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NOTE: To delete a scenario, manually close out of all references to the scenario itself or any of the 
scenario directory sub-tree files, such as log files, rasters, shapefiles, personal geodatabases, and 
file geodatabases in either text editor, ArcCatalog, ArcMap, or Windows Explorer. Failure to do so will 
result in an incorrect sync between the scenario database-related data and their file system-related 
objects. 

6.5 Riverine 
The Hazard / Riverine menu provides the Flood Model riverine analyses for deriving peak flows 
(Hydrology) and associated flood depths and boundaries (Delineation Floodplain). Like other Hazus 
analyses, this menu requires the analyses to be performed in sequential steps. For example, Figure 
6-48 shows the Hydrology and Delineation Floodplain selections active, while the other three 
selections are inactive. 

 

Figure 6-41 Select Hydrology  

6.5.1 Hydrology 
Once the user has defined the scenario, the Hydrology option, on the Hazard > Riverine menu, 
becomes enabled (Figure 6-48). To conduct the hydrologic analysis, select Hydrology and a 
notification window (Figure 6-49) will warn the user that raster processing cannot be canceled. Click 
Yes.  

 

Figure 6-42 Select Yes to Start Hydrologic Analysis 
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A progress bar (Figure 6-50) will appear as Hazus performs the hydrologic analysis. This may take 
several minutes to several hours depending on the size of the Study Region and the number of 
selected streams. A notification (Figure 6-51) will appear once the hydrologic analysis has been 
completed. Click OK. 

 

Figure 6-43 Hydrologic Analysis Progress 

 

 

Figure 6-44 Hydrologic Analysis Completed 

6.5.1.1 Best Practices and Troubleshooting 
There is a tendency for ArcMap and Hazus to experience runtime issues that can lead to the Flood 
Model failing to complete the analysis. Because the hydrologic analysis is specific to the Study 
Region and is dependent only on the river network developed by the user, there are options to 
reduce the possibility of the code reaching a memory limit.  

Performing the hydrologic analysis on a watershed-by-watershed basis is recommended, thereby 
limiting the processing within the model. Here are two recommended approaches: 

1. Create a scenario for each watershed and then perform the hydrologic analysis on each 
scenario. The hydrologic results are stored in a single table independent of scenario.  

2. Create a single scenario, start with one county or watershed, and perform the hydrologic 
analysis. When completed, edit the scenario, add the next county or watershed, and rerun the 
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hydrologic analysis. The model will skip those reaches for which the hydrologic analysis has 
already been performed and will perform the analysis on the added reaches. Repeat as needed 
to complete all watersheds in the Study Region. 

For scenarios with many stream reaches, running the hydrologic analysis for large areas is 
recommended to improve processing time. Figure 6-52 provides an example showing reaches 
selected for analysis (shown in red). 

 

Figure 6-45 Select Streams for Hydrology 

 
When running hydrologic analysis on large stream networks, continue to add streams by editing the 
scenario using the Edit Scenario dialog shown in Figure 6-53. 
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Figure 6-46 Edit Scenario Dialog to Add Streams 

 
Once streams have been added into the scenario, select Hydrology from the Riverine menu as shown 
in Figure 6-54. 

 

Figure 6-47 Select Hydrology  
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The Process dialog (Figure 6-55) will appear and ask if the user wants to continue with the 
processing. Click Yes to continue. Once the hydrologic analysis has started, the process cannot be 
canceled. 

 

Figure 6-48 Hydrology Processing Dialog 

 
Once the user has edited the scenario and added more streams for hydrologic analysis, the 
Overwrite Existing Results dialog will appear (Figure 6-56). If the user selects Yes to overwrite, Hazus 
will overwrite previous hydrology values, which requires more processing time. If the user selects No, 
the new results will be appended to the previous results and stored. 

 

Figure 6-49 Overwrite Hydrology Dialog 

 
Hydrologic analysis is only important for performing frequency-related flood analyses (i.e., 100-year 
return period, annualized loss, etc.). If the user wishes to apply a specific discharge to the reach(es), 
they should proceed directly to the Delineate Floodplain option on the Riverine menu and select 
Single Discharge (see Section 6.5.2). 

When running hydrologic analysis, the Hazus screen might go blank, or the Task Manager 
Applications tab will indicate that Hazus is not responding. This is a common occurrence for any 
process-heavy software. To see whether Hazus is still running, check the Task Manager Processes 
tab and sort the CPU column in descending order. The “ArcMap.exe” process should be on top. If the 
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“System Idle Process” is constantly on top at 99–100%, Hazus is not responding. Also, check the 
Performances tab and make sure the CPU Usage is not 0 over a period of time. Another option is to 
open the Study Region folder (in “Details” view within Windows Explorer) and make sure the 
FlHydrologyLog.txt file is updating by looking at the “Date modified.” 

6.5.1.2 Excluding Problem Reaches from Scenario 
Problem reaches are reaches for which regression equations and/or data are not available. When 
computing the flood hazard, analysis results for a specific return period or suite of return periods will 
not be available for reaches designated as Problem Reaches. Input of discharges will be required to 
develop the flood hazard grids for Problem Reaches. 

Users have the option to set Hazus to automatically remove problem reaches (if they exist) from the 
scenario after the hydrologic process by selecting the Automatically remove problem reach(es) 
checkbox under Customize > Flood Options on the main Hazus menu bar, as shown in Figure 6-57. 

 

Figure 6-50 Flood Options, Check Automatically Remove Problem Reach(es)  

 
If the Automatically remove problem reach(es) checkbox is not selected, at the end of the hydrologic 
process, a Remove Problem Reaches message will appear, as shown in Figure 6-58, to notify the 
user that problem reaches exist in the scenario and to give the user the option to remove the 
problem reaches from the scenario (with one click of Yes button). 
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Figure 6-51 Notification and Option to Remove Problem Reaches 

 
If the user selects No in the Remove Problem Reaches notification, but later wishes to remove 
problem reaches, they can manually edit the scenario to exclude the problem reaches. This only 
applies to cases where the problem reaches exist in the scenario. 

To manually remove problem reaches, click on the Hazard menu, select Scenario, and then click 
Edit. The Edit Scenario dialog will open, as shown in Figure 6-59. Click OK.  

 

Figure 6-52 Edit Scenario Window 
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Once the user clicks OK, all the reaches in the scenario will be highlighted in light blue. Click the 
Remove Problem Reaches button (as shown in Figure 6-60), to remove all the problem reaches, and 
then click the Save selection button. After the user clicks OK, the new scenario will be mapped, 
shown in Figure 6-61. 

 

Figure 6-53 Edit Scenario Dialog to Remove Problem Reaches 

 

 

Figure 6-54 Example Edited Scenario with Problem Reaches Removed 
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The scenario is now ready to start hydraulics (Riverine > Delineate Floodplain) for the Chosen 
Reaches. The hydrologic analysis does not need to be rerun because Hazus has already computed 
discharges for non-Problem Reaches. If the hydrologic analysis is rerun, the results will remain the 
same because the Problem Reaches have been removed from the scenario. 

6.5.2 Delineate Floodplain  
Once the hydrologic calculations are complete, the Delineate Floodplain option on the Hazard > 
Riverine menu is enabled (Figure 6-62). Select Delineate Floodplain to initiate the hydraulic analysis. 
The Riverine Hydraulic Analysis dialog in Figure 6-63 will appear. Use the Analysis Type pull-down 
menu to select the type of hazard analysis to run.  

 

Figure 6-55 Select Delineate Floodplain  
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Figure 6-56 Riverine Hydraulic Analysis Dialog 

 
1. Select Full Suite of Return Periods to calculate flood depths and floodplains for the 10-year, 25-

year, 50-year, 100-year, and 500-year return period floods on each of the stream reaches in the 
scenario. Starting with the 500-year return period, the Flood Model will go through each selected 
reach and develop a single 500-year flood depth grid. This process is duplicated for the other 
four return intervals. This option is required for average annualized loss. 

2. Select Single Return Period to specify a return period between 2 years and 1,000 years for which 
the flood characteristics will be calculated. Choose different return periods for different stream 
reaches, if desired. Depending on the user selection, the resultant grid will be a single return 
interval for all reaches selected by the user, like option 1 above, or a single grid of mixed return 
intervals for the selected reaches. 

3. Select Single Discharge to input anticipated stream discharge levels for each stream reach. Like 
option 2 above, the user can enter different discharges for each reach. 

o If the user opts to run different return intervals or specific discharges for each reach in 
their scenario, the Transportation Bridge analysis cannot be run because the return 
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interval for the reaches in question needs to be specified and has not been defined for a 
single discharge analysis. 

o The Single Discharge option can decrease the runtime significantly if data are available. 

The final delineated floodplain should look like Figure 6-64, where only the selected reaches for the 
scenario have flood depth grids and boundaries delineated. 

 

Figure 6-57 Example Riverine Hydraulic Analysis Results 

6.5.2.1 Best Practices and Troubleshooting 
The Delineate Floodplain analysis can take large amounts of time, especially when generating a 
flood depth grid in Hazus rather than importing a grid. Several days of processing time are possible 
with the Full Suite of Return Periods Analysis Type for an individual county. Some general guidance is 
listed below for the Delineate Floodplain analysis; however, this is not an exclusive list of best 
practices and troubleshooting for issues experienced during the Delineate Floodplain analysis. 
Please contact the Hazus Helpdesk (see Section 1.5) for support regarding specific issues. 

Blank Screen: 

When running the hydraulic analysis, the Hazus screen might go blank, or the Task Manager 
Applications tab will indicate that Hazus is not responding. This is a common occurrence for any 
process-heavy software. To see whether Hazus is still running, check the Task Manager Processes 
tab and sort the CPU column in descending order. The “CoreOfHydraulics.exe” process should be on 
top. If the “System Idle Process” is constantly on top at 99–100%, Hazus is not responding. Also, 
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check the Performances tab and make sure the CPU Usage is not 0 over a period of time. Another 
option is to open the scenario folder (in “Details” view within Windows Explorer) and make sure the 
FlHydraulicsLog.txt file is updating by looking at the “Date modified.” 

Grid Cell Sizes: 

Using a smaller cell size could dramatically increase the processing time and the size of the output 
raster. Resampling larger cells into smaller cells to allow a merged grid for Study Regions with 
different topographic source data may lead to issues in Hazus. The recommended approach would 
be to run the multiple source depth grids separately in Hazus and then combine flood loss results 
after all Hazus loss runs.  

Reaches with Hydraulic Problems: 

If running the hydraulics (i.e., Delineate Floodplain) is taking a long time, the hydraulic process may 
be hanging (i.e., getting stuck on a couple of reaches so that it cannot finish the hydraulics). The 
following instructions will help bypass the problem. 

1. Look in the log (flHydraulicsLog.txt located in Scenario folder) and note any reaches (ReachID) 
that have many errors and did not successfully complete processing. Example below: 

: ----------------------------------------------------------------------- 

 : ReachID: 1425 Core of Hydraulics 

: ----------------------------------------------------------------------- 
modLevelOne - CoreOfHydraulics: Reach 100 of 267 

modLevelOne - CoreOfHydraulics: Return period: 100 

modLevelOne - CoreOfHydraulics: What-if:  

modLevelOne - CoreOfHydraulics: Available memory: 1631.05 mb 

modInitialBuffer - InitBuffer: Reach length = 0.2 km 

modInitialBuffer - InitBuffer: Reference (downstream node) discharge: 3,981 cfs 

modXSections - PlaceInitXsects: Short centerline length: 964.462826043346 feet 

modXSections - PlaceInitXsects: Buffer 3 of 9 

modXSections - PlaceInitXsects: Buffer 4 of 9 

modXSections - PlaceInitXsects: Buffer 5 of 9 

modXSections - PlaceInitXsects: Buffer 6 of 9 
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modXSections - PlaceInitXsects: Buffer 7 of 9 

modXSections - PlaceInitXsects: Buffer 8 of 9 

modXSections - PlaceInitXsects: Buffer 9 of 9 

modXSections - PlaceInitXsects: Cross section count: 3 

modXSections - InitialXSectElevs: Drainage area reset from 219.9631 to 
140.0594 

modXSections - InitialXSectElevs: Drainage area reset from 220.2029 to 
140.0594 

GeometryToFeatureClass: Feature class: LeftBuffer 

GeometryToFeatureClass: Feature class: RightBuffer 

modGeometry - CleanPolygonIslands: Input geometry is nothing, leaving early. 

ModBoundsandEnds - ValidateFloodPolygon: Error Number: 91 

ModBoundsandEnds - ValidateFloodPolygon: Error: Object variable or With block 
variable not set 

modGeometry - CleanPolygonIslands: Input geometry is nothing, leaving early. 

modGeometry - IntersectABS: Input geometry #1 is invalid. No intersection. 

modLimits - NewLimitsandCenterlines: Error Number: 91 

modLimits - NewLimitsandCenterlines: ERROR: Object variable or With block 
variable not set at 8 

modLevelOne - CoreOfHydraulics: Error Number: 91 

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable 
not set at 20 

modLevelOne - CoreOfHydraulics: Error Number: 91 

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable 
not set at 20 

modLevelOne - CoreOfHydraulics: Error Number: 91 
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modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable 
not set at 20 

modLevelOne - CoreOfHydraulics: Error Number: 91 

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable 
not set at 20 

modWsePts - FinalWsePts: Error Number: 5 

modWsePts - FinalWsePts: ERROR: Invalid procedure call or argument at 2 

modLevelOne - CoreOfHydraulics: WARNING: FinalWsePts failed, continuing 
process using points from InitialWsePts and/or IncreaseWsePts 

modLevelOne - CoreOfHydraulics: Error Number: 91 

modLevelOne - CoreOfHydraulics: ERROR: Object variable or With block variable 
not set at 45 

modAddBack - AddBack: Entering 

modAddBack - FillDEMMask: Error Number: 91 

modAddBack - FillDEMMask: ERROR: Object variable or With block variable not set 
at 4 

modAddBack - AddBack: Error Number: 91 

modAddBack - AddBack: ERROR: Object variable or With block variable not set at 
5 

MakePermanent: Entering for grid: 1425 

MakePermanent: Path: 
C:\HazusData\Regions\CharlestonSC3\Hydraulics\Reaches\100 

MakePermanent: Leaving 

modAddBack - AddBack: Leaving 

GeometryToFeatureClass: Feature class: 1425_cl 

ExportGDBFClass: Error: Featureclass Reach1425ConvPGRP100 not found. 

modLevelOne - CoreOfHydraulics: Leaving 
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2. Open the Attribute Table for the Chosen Reaches layer. 

3. Search for the reach using the ArcID and highlight/select the problem reach.  

4. Right click on the line of the selected reach and select Zoom to Selected as shown in Figure 6-65 
below.  

 

Figure 6-58 Chosen Reaches Attribute Table, Zoom to Selected Reach 

 
5. The map will now zoom into the reach selected. Zoom out of the map to locate where the 

selected reach is on the map (Figure 6-66). Keep in mind what the reach looks like. 
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Figure 6-59 Example Selected Chosen Reach (highlighted), Zoomed Out 

 
6. Click on the Hazard menu, select Scenario, then click Edit. 

7. Once the Edit Scenario tool is available, zoom in to the area where the problem reach is located.  

8. Click Remove from selection and select the problem reach. The reach selected will be highlighted 
in red.  

9. Click Save selection. 

10. After the selection has been saved, the problem reach will be dark blue and will be excluded 
from the scenario. 

11. Click OK. 

12. If the scenario is a riverine/coastal scenario, the Shoreline Characterization dialog will appear 
after edits are made to the scenario. The original parameters that were set for the shoreline(s) 
are saved if the shoreline(s) wasn’t added/removed from the scenario. Select the Next and 
Finish buttons if the existing parameters are desired. 

13. The scenario is now ready to re-start hydraulics (Riverine\Delineate Floodplain) for the 
ChosenReaches. The hydraulics process will automatically rerun any reaches that did not 
successfully process in the previous run, skip any reaches that have been successfully 
processed, and then will continue on the last reach processed. If there were any reaches where 
the Task Manager was used to stop Core of Hydraulics, repeat the steps to get past those 
reaches. 
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6.5.2.2 Failed Reaches 
Failed reaches are reaches that have been processed in the hydraulics process, but do not produce 
a flood depth grid. An error message will appear to notify the user when a reach fails during the 
hydraulics process. Click the Close button on any errors and the hydraulics process will continue 
processing the next reach in the queue. The FailedReaches layer will appear on the map after the 
hydraulics process completes, as shown below in Figure 6-68. 

 

Figure 6-60 Example Failed Reaches (purple) on Map after Hydraulics Completed 

 
The hydraulics process should complete even if there are failed reaches. The only reason the 
hydraulics process will not complete is if a failed reach causes the hydraulics process to hang.  

When running the analysis on a scenario with failed reaches, the analysis will only process in areas 
where the depth grid exists. 

6.6 Coastal 
The Hazard / Coastal menu (Figure 6-75) provides the Flood Model coastal analyses for deriving 
flood depths and boundaries (Delineation Floodplain) associated with the coastal flood elevations 
and shoreline segments entered when defining the scenario.  
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Figure 6-61 Select Delineate Floodplain   

6.6.1 Delineate Floodplain 
To delineate the floodplain, select Delineate Floodplain from the Hazard > Coastal menu (Figure 
6-75). The Coastal Hazard Analysis dialog will open (Figure 6-76). This dialog allows the user to 
select from two coastal analysis options:  

1. If the user selects Full Suite of Return Periods from the Analysis Type drop-down menu, Hazus 
will calculate flood depths and floodplains for the 10-year, 25-year, 50-year, 100-year, and 500-
year return period floods for the entire shoreline in the scenario. The Flood Model will produce a 
single flood depth grid for the shoreline for each of the five return intervals. 

2. If the user selects Single Return Period from the Analysis Type drop-down menu, the user can 
specify any flood return period between 10 and 500 years for which the flood characteristics will 
be calculated. Unlike the riverine hazard, the user cannot choose different return periods for 
different shoreline segments. The Flood Model will produce a single flood depth grid for the 
shoreline for the selected return period.  

  
Figure 6-62 Coastal Hazard Analysis Dialog 
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6.6.2 User Inputs, Shoreline Segmentation and Characterization 
The Hazus user is required to supply certain information for the coastal Flood Model to run -- without 
this information no coastal hazard results can be produced. More accurate user-supplied information 
will result in more accurate coastal hazard and economic loss results. The following user inputs are 
required:  

 Study region, over which coastal flood hazards will be computed. The study region boundaries 
must be specified by the user at the beginning of the analysis. Given the region, 4-78 Chapter 4. 
Potential Earth Science Hazards (PESH) the model will determine which coastal counties are part 
of the study region and will locate default data (in look-up tables) associated with each coastal 
county. 

 Shoreline(s). The user must identify the start and end of shorelines across which coastal flooding 
will propagate. Except for small islands, the user may choose to divide each shoreline into two or 
more segments. Segmentation of shorelines is not required (if a shoreline is not segmented, the 
entire shoreline will be attributed with the same shore characterization and 100-yr flood 
conditions). Coastal flood return period(s). The user may specify one or more return periods 
between 10 years and 500 years. A separate coastal hazard analysis will be performed for each 
return period specified. In the Combined Wind and Flood (Coastal Surge) Model, one input 
required to characterize each segment of a shoreline if “No Waves” was selected in the 
Hurricane Surge analysis is:  

o Wave exposure, used to determine whether coastal wave analyses will be run, and if so, 
to determine the peak wave period Tp at the shoreline from a look-up table (default wave 
period data are listed for 364 coastal counties in the table): - open coast (full exposure), 
with over-water fetches > 50 miles - moderate, with fetches between 10 miles and 50 
miles - minimal, with fetches between 1 and 10 miles - sheltered, with fetches less than 
1 mile (Note that if a shoreline or segment is classified as sheltered, the model assumes 
that no damaging waves will affect that shoreline or segment, and no dune/bluff erosion 
or wave analyses will be computed along transects associated with that shoreline or 
segment – a stillwater flood surface will be computed by the model.)  

Two inputs are required to characterize 100-yr flood conditions at each shoreline segment (See 
Figure 6-63:  

 (1) 100-yr Flood Stillwater Elevation (SWEL), obtained from the FIS report or from another source  

 (2) 100-yr wave setup, obtained from the FIS report or from another source. In addition, the user 
may edit certain parameters calculated by the model:  

 (3) Other stillwater elevations (ft): the model calculates values for the 10, 50 and 500-yr based 
on the 100-yr value and default flood elevation ratios; the user may specify site specific values 
from the FIS or another source.  
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(4) Significant wave height Hs at shore (ft): the model assumes depth-limited wave heights at all 
shorelines and exposures; the user may specify a value less than the depth-limited height. 

 

Figure 6-63 Required Shoreline Inputs 

The coastal Flood Model will take the user inputs and default data, then create a stillwater flood 
surface throughout the entire study region (i.e., the coastal model will: 1) overlay a stillwater flood 
surface over the DEM, and 2) identify and remove any isolated pools without a hydraulic connection 
to the flood source). Subsequent erosion and wave analyses will be used to determine where the 
flood surface will lie above the stillwater surface. Figure 6-64 illustrates the overall coastal hazard 
modeling process. 
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Figure 6-64 Overview of Hazus Coastal Flood Hazard Modeling Process 

 

6.6.3 Best Practices and Troubleshooting 
Coastal floodplain delineation in the Flood Model is much less likely to have issues than riverine 
analysis. However, memory issues can still influence a larger coastal analysis. At the bottom of the 
Coastal Hazard Analysis window (Figure 6-62), Hazus indicates how much virtual memory is available 
on the machine and the estimated virtual memory that will be used for the coastal analysis. When 
running the coastal flood delineation analysis, the Hazus screen might go blank, or the Task 
Manager Applications tab will indicate that Hazus is not responding. This is a common occurrence for 
any process-heavy software. To see whether Hazus is still running, check the Task Manager 
Processes tab and sort the CPU column in descending order. The “ArcMap.exe” process should be on 
top. If the “System Idle Process” is constantly on top at 99–100%, Hazus is not responding. Also, 
check the Performances tab and make sure the CPU Usage is not 0 over a period of time. Another 
option is to open the scenario folder (in “Details” view within Windows Explorer) and make sure the 
FlCoastalLog.txt file is updating by looking at the “Date modified.” 
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Section 7. Model Menu: Analysis 
After Hazus has calculated the hazards, it will need to run the loss analysis to provide damage 
estimates using the Analysis menu (Figure 7-1). As with other Hazus Flood Model menus, items 
grayed out represent functionality not currently available given the type of analysis being conducted 
and the completion of required prerequisite analysis steps.    

In a Hazus loss analysis, the characteristics of the structures and people of the Study Region are 
analyzed for vulnerability to the flood or floods that have been calculated in the scenario. Default 
depth damage functions, which estimate percent damage relative to the depth of floodwater as 
measured from the top of the first finished floor (riverine) or bottom of the first floor (coastal), are 
provided within the Hazus program. Other damage functions are also included in the Flood Model to 
estimate damages to vehicles, utility components, and transportation bridges. 

 

Figure 7-1 Analysis Menu 

7.1 Damage Functions 
The Analysis menu options reflect the functions that will be used to estimate damage of various 
types. This section discusses the options on the Analysis > Damage Functions menu.  

 

Figure 7-2 Analysis > Damage Functions Menu 
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Select Buildings from Analysis > Damage Functions menu. The General Building Stock Depth-
Damage Functions table shown in Figure 7-3 will appear. The Structure table provides information on 
the default damage function associated with each specific occupancy class (e.g., RES1) and 
subclass (e.g., RES1, one-story, no basement). Scroll to the right to see the percent of damage, 
expressed in terms of building replacement cost, estimated at different water depths. The pull-down 
menus at the top of the window allow the user to view the default damage functions for the flood 
hazard types (Zone V, Coastal Zone A, and riverine) and other occupancy classes (e.g., COM1, AGR1, 
IND1). Click on the different tabs at the top (Structure, Contents, Inventory) to view default damage 
functions associated with building structures, and their contents, for all specific occupancy types and 
inventory for selected occupancies (e.g.,COM1, IND1-6, AGR1).  

 

Figure 7-3 Building Depth-Damage Functions by Occupancy (Riverine) Table 

 
Click on the Library button in the lower left corner of the Building Stock Depth-Damage Functions 
window. The Structure Damage Functions library shown in Figure 7-4 will appear. Viewing the library 
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of damage functions allows the user to review other damage functions applicable to the occupancy 
under consideration relative to the current default, as well as replace the current default with 
another function from the library.  

 

Figure 7-4 Building Depth-Damage Function Library  

The Library uses color codes to help the user identify any changes and selections they may make in 
the dialog. The Library dialog comprises three windows.  

The left window is the navigation window where the user can change between occupancies, 
foundation heights, and number of stories. This window allows the user to select a specific 
occupancy (e.g., RES1) and shift through the potential foundation types (slab on grade, fill, 
basement, crawlspace, pier, post, and pile) and number of stories typical for the selected specific 
occupancy (one-story, two-story, three-story, split level for residential and low-, mid-, and high-rise for 
non-residential) within that occupancy. The sub-occupancies displayed in the window (shown in the 
first column) are a form of shorthand that identifies the occupancy class. The shorthand was 
developed by taking the first letter and numeric values of the specific occupancy name (e.g., RES1 
becomes R1 and COM10 become C10); this is concatenated with the value for the number of stories 
(e.g., two-story becomes 2 and low-rise becomes L), and finally the existence of a basement derives 
the last value (e.g., structures with a basement get a B and structures without a basement get an N). 
Therefore, the residential occupancy classified as RES1 with one story and no basement becomes 
R11N while the commercial occupancy classified as COM10, mid-rise, with a basement becomes 
C10MB. 
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The bottom right window is where the library of damage functions is displayed for the user to view 
and/or select. The user can browse between damage functions for the foundation and number of 
stories by selecting the sub-occupancies in the left column grid. In this case, Figure 7-4 displays all 
the functions available for the sub-occupancy R11N (RES1, one- Story, with no basement). Selection 
of C10MB (COM10, mid-rise, with basement) would display an entirely different set of damage 
functions in the grid on the lower right. 

Finally, the window in the upper right allows the user to make comparisons and selections among 
the damage functions. The first row in the grid will always display the Hazus default function in red. 
The second line in the upper right grid displays the “current” function or any damage function that 
the user has highlighted in the lower window. To help the user view the current function, it is also 
displayed in green text. The user may want to use the “current function” line as a way of displaying a 
function and directly comparing it to the default damage function. Figure 7-4 displays a U.S. Army 
Corps of Engineers (USACE) New Orleans District damage function (highlighted row 10) for RES1, 
one- story, slab on grade. The third row in the upper right grid displays any function the user may 
have “selected” as their damage function. That is, a damage function the Flood Model will use rather 
than the default damage function. This is how the user can override the default damage functions 
with either a library function that they believe better represents the local area or a custom function 
they have built themselves as described below.  

Figure 7-5 displays a USACE New Orleans District damage function (lower right grid, blue text RES1, 
one-story, pier foundation) that was selected in place of the default function. If the user chooses, 
they may use one of the library functions to build their own custom damage function. To do this, click 
the User Defined button in the lower left corner of the dialog. When the user selects this button, the 
Flood Model takes the highlighted damage function, if any, and opens an editable dialog (Figure 7-6) 
for the user to make modifications. The Flood Model inserts the damage function description from 
the starting damage function the user selected (or the default damage function if none is selected) 
and adds a comment that identifies the original source damage function. This allows the user to 
remember where they started the process. The user is required to enter a source (or name) for the 
damage function. Editing of the Enter Comment or Enter DmgFn Description fields is not 
recommended. 
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Figure 7-5 Building Depth-Damage Function Library User-Defined Option 

  

 

Figure 7-6 Editing Dialog for User-Defined Function Development  

If the user has decided to select a new damage function for use in the Flood Model, the entry dialog 
will highlight the damage function to remind the user that a default function is not being used. Figure 
7-7 shows how the change would appear in the entry dialog as compared to that shown earlier in this 
section in Figure 7-3 using a User-Defined Depth-Damage Function. 
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Figure 7-7 Building Depth-Damage Function Dialog with a User-Defined Damage Function  

 
Similar default damage functions are available for other facilities from the Damage Functions menu, 
as shown in Figure 7-8 below. The damage function dialogs for Essential Facilities function in the 
same way as those discussed above for the General Building Stock. In most cases, the damage 
functions available in the Essential Facilities dialog area also available for the Government 
structures in GBS. The Essential Facilities dialog does not have an inventory tab because the 
Essential Facilities occupancies do not produce inventory for sale. 

 

Figure 7-8 Analysis > Damage Functions Menu 
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The Transportation Systems damage function dialog looks slightly different as there is only a 
structure damage function (no contents or inventory), and the dialog’s tabs allow the user to shift 
between highway, railway, and light rail facilities.  

 Currently, the Flood Model has damage functions for bridges only related to highway, railway, 
and light rail facilities.  

 The Transportation Systems damage functions for bridges are based on return period. An 
analysis cannot be performed on bridges if the user assigns mixed return periods on the selected 
reaches. In other words, if the user assigns a different return period to each reach, or a single 
discharge on the reaches, the Flood Model will not be able to analyze the bridges. 

Figure 7-9 shows the Damage Functions for Transportation System table, which has the same table 
columns for highway, railway, and light rail facilities. 

 

Figure 7-9 Transportation Damage Function Table 
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Figure 7-10 shows the Damage Functions For Utility System table. As with the Transportation 
Systems, the tabs allow the user to choose the utility type for review. Note, there are no 
communication facility damage functions currently available. 

 

Figure 7-10 Utility Facility Damage Function Table 
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Figure 7-11 shows the Damage Functions For Vehicles table. 

 

Figure 7-11 Vehicle Damage Functions Table 

7.2 Restoration Functions 
The Flood Model provides restoration functions for GBS and Essential Facilities. The GBS restoration 
functions are discussed in the Analysis > Parameters menu discussion, as the GBS values are 
included in the Direct Economic parameter tables. Built from the restoration timelines for the related 
GBS occupancies, the Essential Facilities restoration models provide the user with a general 
indication of the maximum restoration time for 100% operations. Obviously, there will be a great deal 
of effort to quickly restore Essential Facilities to full functionality and therefore, this will be an 
indication of the maximum downtime. 

Selecting Essential Facilities from the Analysis / Restoration Functions menu (Figure 7-12) opens the 
dialog shown in Figure 7-13. In this case, the figure shows the dialog on the Medical Care Facilities 
tab. The Restoration Functions are editable, and the user can adjust the MaxDaysToRestoration 
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column and the FunctionalDepth column (scroll to the right). These values are based on the depth of 
flooding at the specific facility (the latitude and longitude). 

 

Figure 7-12 Analysis > Restoration Functions Menu 

 

 

Figure 7-13 Essential Facilities Restoration Functions Table 
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7.3 Parameters 
There are several parameters the user may want to view and/or modify before starting the analysis. 
This section walks the user through the available parameters. Every effort has been made to provide 
default values wherever possible, which allow the model to perform most requested analysis without 
user intervention.  

The Analysis > Parameters menu appears in Figure 7-14. The menu provides access to the default 
parameters used in the analysis of Debris, Shelter, and Direct Economic.  

 

Figure 7-14 Analysis > Parameters Menu 

 
Selection of the Debris menu item opens an editable Debris Parameters dialog (Figure 7-15) that 
allows the user to view the default debris values. Debris is estimated based on the depth of flooding 
within the structure, like the estimation of GBS damage, specific occupancy, and whether the 
foundation has a footing or a slab. The user can use the combo boxes to shift between specific 
occupancies and the foundation types.  

Debris is estimated in three main classifications that align loosely with the earthquake models 
method of classification: finishes (dry wall, flooring, insulation, etc.), structure (framing, walls, 
exterior cladding), and foundation weight (concrete slab, concrete block, or other foundation). Unlike 
the earthquake model, where moderate damage may still result in the foundation being removed, 
flooding requires the structure to be considered substantially damaged before the foundation is 
removed. The weights are in tons per thousand square feet of the structure. 
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Figure 7-15 Debris Analysis Parameters Table 

 
The Direct Economic parameter menu item opens the Direct Economic Loss Parameters dialogs, 
which includes three tabs shown in Figure 7-16 through Figure 7-18. This dialog provides the user 
with access to the default parameters that control the estimation of the direct damages to the GBS. 
This includes the impact of the flood scenario on the wages, income, inventory, and maximum 
restoration time for the GBS. The Business Inventory tab defines the amount of inventory in the 
Study Region based on the square footage of specific Census blocks. 
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Figure 7-16 Direct Economic Loss – Business Inventory Table 

 
The GBS restoration functions define the maximum amount of time it should take for any given 
specific occupancy to be restored. For example, in Figure 7-17 the RES1 restoration time is based on 
the depth of flooding within the structure. In the case of RES1, even though the water has not fully 
entered the structure, it may take up to a year to clean up the structure, replace any sub-flooring that 
may be damaged, obtain permits, and perform inspections. This is a maximum timeline meant to 
provide a conservative estimate for the losses associated with the restoration process. 
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Figure 7-17 Direct Economic Loss –Restoration Time Table 

 
Figure 7-18 shows some additional parameters used to develop the direct losses for wages and 
capital income presented in the GBS economic losses. 
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Figure 7-18 Direct Economic Loss – Rental, Owner-Occupied, Wages and Capital, and Recapture 
Features Table 

7.4 Annualized Loss 
Average Annualized Loss Menu, shown in Figure 7-19, is the calculation step where a user combines 
a series of individual recurrence interval losses into an additional estimate for annual loss. This 
analysis is performed after the user has performed a Full Suite of Return Periods analysis in the 
Hazard menu (as shown in Figure 7-20 and Figure 7-21 for riverine and coastal analysis) and has 
performed a loss analysis in the Analysis > Run menu.  
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Figure 7-19 Analysis > Average Annualized Loss Menu 

 

 

Figure 7-20 Riverine Flood Full Suite of Return Periods Analysis 

 

 

Figure 7-21 Coastal Flood Full Suite of Return Periods Analysis 
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The user has the option of performing average annualized loss calculations for either GBS or UDF 
data, as shown in the Average Annualized Loss Analysis dialog (Figure 7-22) if loss analysis has been 
performed for the five required events (10-, -25-, 50-, 100-, and 500-year). 

 

Figure 7-22 Average Annualized Loss Analysis Dialog 

 
If the user has not performed the required loss analysis prior to trying to run the Average Annualized 
Loss (AAL), Hazus will produce the error messages shown in Figure 7-23 and Figure 7-32 requesting 
the user to perform these prerequisite analyses.  

 

Figure 7-23 Average Annualized Loss GBS Error Dialog 

 

 

Figure 7-24 Average Annualized Loss UDF Error Dialog 
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7.5 Combined Wind and Flood 
The Combined Wind and Flood menu (Figure 7-25) will become activated when a user has performed 
the prerequisite analysis for a storm surge analysis in both the Hurricane Model and Flood Model. 
See Section 11 for more details on all the steps to perform this type of analysis. 

 

Figure 7-25 Analysis > Combined Wind and Flood Menu 

7.6 Run 
Once the user parameters have been selected or modified, select Run from the Analysis menu 
(Figure 7-26). The Analysis Options dialog shown in Figure 7-27 will appear. Clicking on the plus and 
minus signs will expand and collapse the lists of available options, respectively. Click on the boxes of 
the desired analysis options. A check mark will appear to indicate the options have been selected. 
Note that some analysis options have pre-requisite analysis requirements and selection of those 
options will automatically check the box of the prerequisites. At the bottom of the dialog, Hazus will 
indicate the amount of hard drive disk space available on the machine and the percentage of the 
Study Region’s database that has been used thus far. The Study Region’s database has a limit of 10 
GB; therefore, if the percentage used is more than 50%, less than 5 GB of space is available for the 
analysis. 

 

Figure 7-26 Analysis > Run Menu 
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Figure 7-27 Select Analysis Options 

Hazus can conduct default analysis runs for the following items: 

 GBS 

 Essential facilities 

 Selected infrastructure, including highway bridges and water systems 

 Vehicles 

 Debris 

 Shelter requirements 
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The types of baseline data provided for the Study Region limit the type of analysis that can be run. To 
run a What-If analysis, the same analysis must have been run from the hazard menu. When the 
desired analysis options have been selected, click OK. 

 When running the Analysis, the Hazus screen might go blank, or the Task Manager Applications 
tab will indicate that Hazus is not responding. This is a common occurrence for any software 
process-heavy software. To see whether Hazus is still running, check the Task Manager 
Processes tab and sort the CPU column in descending order. The “sqlservr.exe” process should 
be on top. If the “System Idle Process” is constantly on top at 99–100%, Hazus is not 
responding. Also, check the Performances tab and make sure the CPU Usage is not 0 over a 
period of time. Another option is to open the scenario folder (in “Details” view within Windows 
Explorer) and make sure the FlAnalysisLog is updating by looking at the “Date modified.” 

 Running the Analysis, specifically the General Building Stock Damage and Loss, can take up too 
many hours to process and successfully complete. 

For users who would like to view the intermediate analysis completion status, go to Customize menu 
and select Flood Options (as shown in Figure 7-28), and check the Show redo analyses Warning 
message box(es) checkbox (example shown in Figure 7-29). This option only applies if the user is 
redoing the analyses. 

 

Figure 7-28 Customize > Flood Options Menu 
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Figure 7-29 Check Show Redo Analyses Warning Message Box(es) 
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Section 8. Model Menu: Results 
The Results menu (Figure 8-1) within Hazus has several analysis types and menus from which to 
choose. These options enable the user to select the appropriate results to review in the Study 
Region. This section explains each selection and menu to further the user’s understanding of these 
options. 

 

Figure 8-1 Results Menu 

8.1 View Current Scenario Results By 
Once the loss analysis has been run, the next step is to view the results. The first option within the 
Results menu (Figure 8-2) is View Current Scenario Results By…. Selecting this option activates the 
View Results by window shown in Figure 8-3. Select one of the Available Results. No results can be 
viewed until a hazard analysis has been selected. 
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Figure 8-2 Results > View Current Scenario Results By Menu 

 

 

Figure 8-3 Select Available Results 
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8.2 Flood Hazard Map 
To map the flood depth grid and floodplain boundary for the current scenario and return 
period/discharge(s), select Thematic Map of Depth from the Results > Flood Hazard Maps menu. 
The flood depth grid will be displayed in blue. The floodplain boundary will be displayed in orange in 
the main Flood Model map window. 

In the Results > Flood Hazard Maps menu (Figure 8-4), Thematic Map of Depth, will add specific 
symbolized layers to the map. This option can be used as visualization tools to understand specific 
spatial patterns in the Study Region. 

Hazus automatically maps the flood depth grid and floodplain boundary for one of the available 
depth grids when the hazard is computed, but other flood depth grids are available to be mapped 
that may have also been computed. 

 

Figure 8-4 Results > Flood Hazard Maps Menu 

8.3 General Building Stock Damage  
To view and map the general inventory damage results By Occupancy, By Building Type, By Count 
and by Economic Loss, select General Building Stock from the Results menu (Figure 8-5).  
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Figure 8-5 Results > General Building Stock Menu  

8.3.1 General Building Stock Damage by Occupancy 
Select By Occupancy from the Results > General Building Stock menu (Figure 8-5) to view and map 
tabular damage results by Census block. The user can show values based on General Occupancy 
Type or Specific Occupancy Type and choose between Pre-Firm, Post-Firm, or All (Figure 8-6). Select 
a specific column with numeric values in the table and click the Map button to map the tabular 
results. Mapped results will appear on the screen.  
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Figure 8-6 General Building Stock Damage Results Table 

8.3.2 General Building Stock Damage by Building Type 
Select By Type from the Results > General Building Stock menu (Figure 8-5) to view and map tabular 
damage results for wood, steel, concrete, masonry, and manufactured housing types. Select the 
desired type of structure from the drop-down menu (Figure 8-7). 
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Figure 8-7 Building Stock Damage by Building Type Table 

8.3.3 General Building Stock Damage Count 
Select By Count from the Results > General Building Stock menu (Figure 8-5) to view and map the 
tabular damage results. For County by Occupancy, the user can choose counts based on General 
Occupancy Type or Specific Occupancy Type and choose between Pre-Firm, Post-Firm, or All (Figure 
8-8). Use the drop-down menus to select which data to view. 
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Figure 8-8 General Building Stock Damage Count Table 

8.3.4 General Building Stock Direct Economic Losses 
The Economic Loss option on the Results > General Building Stock menu allows the user to view and 
map economic losses for the GBS by Census block by full replacement value and depreciated 
replacement value. Direct economic losses can be displayed By General Occupancy, By Specific 
Occupancy, By General Building Type, and Total as shown in Figure 8-9. Use the drop-down menus to 
select which data to view. 
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Figure 8-9 General Building Stock Direct Economic Losses for Full Replacement Value (By 
General Occupancy) Table 

8.3.5 Viewing and Exporting Data from Building Stock Damage Menus 
To view the damage results spatially, click on one of the columns with loss values, such as the 
TotalLoss field (Figure 8-10) on the desired tab of the Direct Economic Losses table and click the 
Map button at the bottom right-hand corner. The data will appear a new data layer within the Hazus 
project and Esri shapefile format. Once the data are listed in the Flood Map Table of Contents, right 
click on the data layer, and export the data to a shapefile, which can be imported into database and 
spreadsheet programs for further analysis.  

To view the damage results only in a tabular format, right click within the table and select Export 
(Figure 8-11). 
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Figure 8-10 General Building Stock Direct Economic Losses for Full Replacement Value (Total) 
Results 
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Figure 8-11 Export General Building Stock Direct Economic Losses for Full Replacement Value 
(By Occupancy) Results 

8.4 Combined Wind and Flood Loss 
When a storm surge analysis has been performed (see Section 11 for all steps in that type of 
analysis), the user can show results from the combined wind flood loss analysis with the Combined 
Wind and Flood Loss menu (Figure 8-12). Selecting that menu will bring up the window shown in 
Figure 8-13, which includes some of the fields that Hazus calculated when a combined hurricane 
wind and flood surge analysis was conducted, where results are shown for each hazard type 
individually and the weighted combination. The combined losses are weighted based on how each 
hazard type contributes to overall damages, with flood hazards typically damaging the lower portions 
of a structure (foundation, lower floors) and hurricane wind hazards typically damaging upper 
portions of a structure (roof, upper floors). Refer to the Hazus Flood and Hurricane Technical 
Manuals for more details on how the combined results are calculated.  
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Figure 8-12 Results > Combined Wind and Flood Loss Menu 
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Figure 8-13 Combined FL/HU Surge Direct Economic Losses for Full Replacement Value (By 
General Occupancy) Table 

8.5 Essential Facilities 
Essential Facilities results, selected in Figure 8-14 and shown in Figure 8-15, allow the user to view 
and map losses and damages to Essential Facilities, including Medical Care Facilities, Emergency 
Centers, and Schools. See Section 8.3.5 for general methods to create maps and export data from 
the Flood Model results.  
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Figure 8-14 Results > Essential Facilities Menu 

 

 

Figure 8-15 Essential Facilities (Medical Care Facilities) Table 
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8.6 User-Defined Facilities 
User-Defined Facilities results, selected in Figure 8-16 and shown in Figure 8-17, allow the user to 
view and map losses and damages to individual UDFs. See Section 8.3.5 for general methods to 
create maps and export data from the Flood Model results. 

 

Figure 8-16 Results > User-Defined Facilities Menu 
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Figure 8-17 User-Defined Facilities Loss Table 

8.7 Transportation Systems 
Transportation Systems results, selected in Figure 8-18 and shown in Figure 8-19, allow the user to 
view and map losses and damages to transportation systems, including Highway, Railway, Light Rail, 
Bus, Port, Ferry, and Airport. However, losses from flood will only be calculated for bridges and only 
as they relate to scour. See Section 8.3.5 for general methods to create maps and export data from 
the Flood Model results. 
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Figure 8-18 Results > Transportation Systems Menu 
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Figure 8-19 Transportation Systems Damage/Economic Loss (Highway) Table 

8.8 Utility Systems 
Utility Systems results, selected in Figure 8-20 and shown in Figure 8-21, allow the user to view and 
map losses and damages to utility systems, including Potable Water, Wastewater, Oil, Natural Gas, 
Electric Power, and Communications. See Section 8.3.5 for general methods to create maps and 
export data from the Flood Model results. 
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Figure 8-20 Results > Utility Systems Menu 

 

  

Figure 8-21 Utility Systems Damage/Economic Loss (Waste Water Treatment Plants) Table 



Hazus Flood Model User Guidance 

 Page 8-19 

8.9 Vehicles 
Vehicles results, selected in Figure 8-24 and shown in Figure 8-25, allow the user to view and map 
losses and damages to vehicles by Census block and for either night or day times. See Section 8.3.5 
for general methods to create maps and export data from the Flood Model results. 

  

Figure 8-22 Results > Vehicles Menu 
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Figure 8-23 Vehicle Damage and Loss (Damage) Table 

8.10 Debris 
Debris results, selected in Figure 8-26 and shown in Figure 8-27, allow the user to view and map 
finish, structural, and foundation building debris results by Census block. See Section 8.3.5 for 
general methods to create maps and export data from the Flood Model results. 
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Figure 8-24 Results > Debris Menu 

 

  

Figure 8-25 Debris Generation Table 
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8.11 Shelter 
Shelter results, selected in Figure 8-30 and shown in Figure 8-31, allow the user to view and map the 
estimated displaced population and the short-term shelter needs by Census block. See Section 8.3.5 
for general methods to create maps and export data from the Flood Model results. 

  

Figure 8-26 Results > Shelter Menu 
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Figure 8-27 Shelter Table 

8.12 Summary Reports 
The Summary Reports results, selected in Figure 8-34 and shown in Figure 8-35, allow the user to 
view and print a wide variety of reports on topics, including Inventory, Buildings, Lifelines, and 
Losses. The reports are created using the Crystal Reports engine that is included as part of Hazus 
installation. Figure 8-36 and Figure 8-37 show examples of the many reports available, as listed in 
Table 8-1. Figure 8-37 shows the report-viewing window in Hazus, which contains icons along the top 
to export or print reports and navigate through report pages. For example, the left-most icon (as 
shown in Figure 8-36) allows the user to export a report in pdf format. Figure 8-38 shows the export 
window for the user to select the report export format and file location. 
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Figure 8-28 Results > Summary Reports Menu 
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Figure 8-29 Summary Reports (Inventory) Window 

 

 



Hazus Flood Model User Guidance 

 Page 8-26 

 

 

Figure 8-30 Example – Transportation Systems Exposure Summary Report 
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Figure 8-31 Example – Building Damage By General Occupancy Summary Report 
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Figure 8-32 Report Export 

 
 

Table 8-1: List of Summary Reports 

Tab Report Description 

Inventory Building Stock Dollar 
Exposure by Building Type 

Dollar exposure (in thousands of dollars) of the building 
stock by building type in the Study Region. 

Inventory Building Stock Dollar 
Exposure by Occupancy 

Dollar exposure (in thousands of dollars) of the building 
stock by occupancy in the Study Region. 

Inventory Transportation Systems 
Dollar Exposure 

Dollar exposure (in thousands of dollars) of the 
transportation systems in the Study Region. 

Inventory Utility System Dollar 
Exposure 

Dollar exposure (in thousands of dollars) of the utility 
system in the Study Region. 

Inventory Vehicle Dollar Exposure 
(Day) 

Dollar exposure (in thousands of dollars) of vehicles 
(during the day) in the Study Region. 

Inventory Vehicle Dollar Exposure 
(Night) 

Dollar exposure (in thousands of dollars) of vehicles 
(during the night) in the Study Region. 

Buildings Building Damage by 
Building Type 

Building damage (square footage distribution by 
percent damage) by building type caused by the hazard 
in the scenario. All values are in thousands of square 
feet. 

Buildings Building Damage by 
General Occupancy 

Building damage (square footage distribution by 
percent damage) by general occupancy caused by the 
hazard in the scenario. All values are in thousands of 
square feet. 
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Tab Report Description 

Buildings 
Building Damage by 
General Occupancy (Post-
FIRM) 

Building damage (square footage distribution by 
percent damage) by general occupancy (Post-FIRM) 
caused by the hazard in the scenario. All values are in 
thousands of square feet. 

Buildings 
Building Damage by 
General Occupancy (Pre-
FIRM) 

Building damage (square footage distribution by 
percent damage) by general occupancy (Pre-FIRM) 
caused by the hazard in the scenario. All values are in 
thousands of square feet. 

Buildings Building Damage Count by 
General Building Type 

Building damage (building count by percent damage) by 
general building type caused by the hazard in the 
scenario. 

Buildings Building Damage Count by 
General Occupancy 

Building damage (building count by percent damage) by 
general occupancy caused by the hazard in the 
scenario. 

Buildings 
Building Damage Count by 
General Occupancy (Post-
FIRM) 

Building damage (building count by percent damage) by 
general occupancy (Post-FIRM) caused by the hazard in 
the scenario. 

Buildings 
Building Damage Count by 
General Occupancy (Pre-
FIRM) 

Building damage (building count by percent damage) by 
general occupancy (Pre-FIRM) caused by the hazard in 
the scenario. 

Buildings 
Emergency Operation 
Center Damage & 
Functionality 

Damage and functionality of Emergency Operation 
Center caused by the hazard in the scenario. 

Buildings Fire Station Damage & 
Functionality 

Damage and functionality of Fire Stations caused by the 
hazard in the scenario. 

Buildings Hospital Damage & 
Functionality 

Damage and functionality of Hospitals caused by the 
hazard in the scenario. 

Buildings Police Station Damage & 
Functionality 

Damage and functionality of Police Stations caused by 
the hazard in the scenario. 

Buildings School Damage & 
Functionality 

Damage and functionality of Schools caused by the 
hazard in the scenario. 

Lifelines Highway Bridge Damage & 
Functionality 

Damage and functionality of Highway Bridges caused by 
the hazard in the scenario. 

Lifelines Light Rail Bridge Damage & 
Functionality 

Damage and functionality of Light Rail Bridges caused 
by the hazard in the scenario. 

Lifelines Potable Water Facility 
Damage 

Damage to Potable Water Facilities caused by the 
hazard in the scenario. 
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Tab Report Description 

Lifelines Railroad Bridge Damage & 
Functionality 

Damage and functionality of Railroad Bridges caused by 
the hazard in the scenario. 

Lifelines Wastewater Facility 
Damage 

Damage to Wastewater Facilities caused by the hazard 
in the scenario. 

Induced Debris Generated Estimated total of debris generated (in tons) by the 
hazard in the scenario. 

Losses 
Annualized Direct 
Economic Losses for 
Buildings 

Annualized direct economic losses (in thousands of 
dollars) for buildings resulting from the hazard in the 
scenario. 

Losses Combined Wind and Surge 
Loss 

Direct economic losses (in thousands of dollars) for the 
combined results from wind and flood hazards in a 
storm surge scenario. 

Losses 
Depreciated Direct 
Economic Losses for 
Buildings 

Depreciated direct economic losses (in thousands of 
dollars) for buildings resulting from the hazard in the 
scenario. 

Losses Direct Economic Losses for 
Buildings 

Direct economic losses (in thousands of dollars) for 
buildings resulting from the hazard in the scenario. 

Losses Direct Economic Losses for 
Transportation 

Direct economic losses (in thousands of dollars) for 
transportation resulting from the hazard in the scenario. 

Losses Direct Economic Losses for 
UDFs 

Direct economic losses for user-defined facilities (UDFs) 
resulting from the hazard in the scenario. 

Losses Direct Economic Losses for 
Utilities 

Direct economic losses (in thousands of dollars) for 
utilities resulting from the hazard in the scenario 

Losses Direct Economic Losses for 
Vehicles (Day) 

Direct economic losses (in thousands of dollars for 
vehicles (during the day) resulting from the hazard in 
the scenario. 

Losses Direct Economic Losses for 
Vehicles (Night) 

Direct economic losses (in thousands of dollars) for 
vehicles (during the night) resulting from the hazard in 
the scenario. 

Losses Shelter Requirements 
Estimated number of persons to seek temporary shelter 
in public shelters as a result of the hazard in the 
scenario.  
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Tab Report Description 

Other Flood Global Risk Report 

Includes general description of the region, building 
exposure by occupancy type (one for the Study Region 
and another for the scenario), expected building 
damage by occupancy and expected building damage 
by building type, expected damage to Essential 
Facilities, debris generated, shelter requirements, 
building-related economic loss estimates, and regional 
population and building value data. 

Other Quick Assessment 

Includes regional statistics (area in square miles, 
number of Census blocks, number of buildings, number 
of people in the region, building exposure) and scenario 
results (shelter requirements and economic loss)  
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Section 9. Model Menu: Other Items 
This section addresses the File menu, the Help menu, and the Customize menu. The primary focus is 
on any menu items that are different in the Hazus version of ArcMap compared with a typical ArcMap 
instance. 

9.1 File Menu 
The File menu, shown in Figure 9-1, is largely the same as the usual ArcMap File menu. The only two 
differences are the first two items: Switch Hazard… and Study Region Wizard…. 

 

Figure 9-1 Hazus File Menu 

 
The Switch Hazard option opens the Select Hazard dialog (Figure 9-2), which allows the user to 
switch between hazard types if the region was created with multiple hazards. Figure 9-2 shows an 
example related to storm surge where the Study Region has data and analyses for both the 
Hurricane Model and the Flood Model. When the user selects a new hazard, ArcMap will close and 
re-open with the selected hazard. 
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Figure 9-2 Select Hazard Dialog 

The Study Region Wizard… option opens the Hazus startup screen (Figure 9-3). The only option 
available is Open a region. Click OK to select from any of the previously created regions and launch 
ArcMap.  

 

Figure 9-3 Study Region Wizard 



Hazus Flood Model User Guidance 

 Page 9-3 

The remaining File menu options are the same as those normally found in ArcMap. Please refer to 
Esri documentation for any questions regarding these options. 

9.2 Help Menu 
The Help menu, shown in Figure 9-4, is largely the same as the usual ArcMap Help menu. The only 
two differences are the Obtaining Technical Support… and About Hazus-MH options. 

 

Figure 9-4 Hazus Help Menu 

 
Selecting the Obtaining Technical Support… option will open the Technical Support window (Figure 
9-5), which provides a phone number and email address for the user to refer any technical questions 
regarding Hazus. 

 

Figure 9-5 Technical Support Window 

 
Selecting the About Hazus-MH option will open the About Hazus window (Figure 9-6), which shows 
the copyright information for Hazus. 
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Figure 9-6 About Hazus Window 

 
The remaining options on the Help menu are the same as those normally found in ArcMap. Please 
refer to Esri documentation for any questions regarding these options. 

9.3 Customize Menu 
The Customize menu, shown in Figure 9-7, is largely the same as the usual ArcMap Customize menu. 
The only addition to the menu is Flood Options…. 

 

Figure 9-7 Hazus Customize Menu 

 
Selecting Flood Options… will open the Flood Options window (Figure 9-8), which has four tabs: 
Startup Options (Figure 9-8), Raster Options (Figure 9-9), Automation (Figure 9-10), and Repository 
(Figure 9-11). The Startup Options tab gives the user some choices of what will appear when a Hazus 
ArcMap document is launched.  
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Figure 9-8 Flood Options (Startup Options) Window 

 
The Raster Options tab gives the user control over how rasters will be symbolized and displayed in 
the Table of Contents. 

 

Figure 9-9 Flood Options (Raster Options) Window 
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The Automation tab (Figure 9-10) allows the user the set the parameters for a scenario to run from 
stream networks. To run: 

1. Select the Run Automation checkbox. 

2. Enter the Drainage Area for the Study Region. 

3. DEM Path is automatically included based on the previous DEM analysis. Editing the path will 
have no effect on the DEM or DEM Path. 

4. Enter a Scenario Name (the name must be unique). All reaches that are developed by the stream 
network will be selected and included in the scenario. 

5. Select a Return Period. If the user selects the Single return period, Hazus will run through the 
GBS analysis. If the user selects the Suite option, Hazus will run through the GBS analysis and 
the AAL analysis. 

6. Click OK. 

 

Figure 9-10 Flood Options (Automation) Window 

 
The Repository tab allows the user to control where output data is stored. 



Hazus Flood Model User Guidance 

 Page 9-7 

 

Figure 9-11 Flood Options (Repository) Window 

 
The remaining items on the Customize menu are the same as those normally found in ArcMap. 
Please refer to Esri documentation for any questions regarding these options. 
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Section 10. Advanced Hazus Analysis: User-Defined 
Inventory Data 

The Hazus baseline data inventory provides many datasets that support analysis, but in certain 
areas, a custom dataset may be more relevant to the Study Region being analyzed. Although Hazus 
data for a given location includes default inventory data for most data types, users may want to edit 
existing data or input their own data for certain type of analysis. Users should perform all data 
editing and entry using the Hazus Comprehensive Data Management System (CDMS) (Figure 10-1). 
CDMS will use Hazus Flood Model default values when critical attributes have not been populated 
(see Section 10.1 for baseline values). When CDMS is used to update the user-defined inventory 
data at the state level, these updated data will automatically be included in any Hazus Study Regions 
for that state. Details on using CDMS to import UDF and data requirements can be found in the 
Hazus Comprehensive Data Management System User Guidance.  

 

Figure 10-1 Hazus Comprehensive Data Management System 

10.1 UDF Required Attributes 
Table 10-1 presents the attributes required for analysis of UDFs within the Flood Model. If any of the 
attributes are not imported (i.e., mapped), Hazus will populate them with baseline values. Although 
those values can be edited later through the Hazus interface, doing so is not practical for such a 
large number of records. Therefore, having the correct values in the imported file is more efficient 
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than editing them later. Note that the minimum required attributes for UDF analysis in Hazus are 
indicated by “Yes”, however, the minimum required attributes for CDMS are only Occupancy Type 
and Building Area. More detailed information about preparing UDF for import via CDMS is available in 
the CDMS User Guide. 

Table 10-1 UDF Attribute Descriptions 

Attribute Description Minimum 
Requirement Field Type Comments 

ID Hazus-assigned 
unique identifier 
for each record  

Yes  
(generated by 

Hazus) 

Text,  
Length: 8 

If the user wants 
to include their 
own unique 
identifier for 
each structure, 
suggested fields 
are “Name” and 
“Comment.”  

Name Structure name No Text,  
Length: 40 

This field can be 
used for user’s 
unique identifier 
for each 
structure, which 
may be local 
parcel ID if 
available. 

Address Structure street 
address 

No Text,  
Length: 40 

 

City Structure city No Text,  
Length: 40 

 

State Structure state No Text,  
Length: 2 

 

ZipCode Structure zip 
code 

No Text,  
Length: 10 

 

Contact Structure 
additional 
contact 

No Text,  
Length: 40 

 

Phone Structure phone No Text,  
Length: 14 

 

https://www.fema.gov/sites/default/files/2020-09/fema_hazus_CDMS_user-guidance_4.2.pdf
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Attribute Description Minimum 
Requirement Field Type Comments 

Occupancy Hazus-specific 
occupancy type 

Yes Text, 
Length: 5 

CDMS requires 
that occupancy 
type is defined by 
the user. See 
Hazus technical 
manuals or 
Hazus Inventory 
menu for 
detailed list of 
Hazus-specific 
occupancies. 

     

Cost Building 
replacement 
value = cost to 
replace the 
building in case 
of damage in 
whole dollars 
(not thousands)  

Yes Currency, 
 

Primary source 
should be cost-
estimating 
guides, such as 
RSMeans 
($/sq.ft). CDMS 
will use Area, 
Occupancy and 
RSMeans tables 
to estimate Cost 
if not provided by 
the user. 

YearBuilt Year structure 
was built 

No Number User should 
provide the year 
built between 
1500 and 2100 

Area Building 
finished floor 
area in square 
feet 

Yes Real, 
Length: 40 

Required from 
user. CDMS will 
use Area, 
Occupancy and 
RSMeans tables 
to estimate Cost 
if not provided by 
the user. 

NumStories Number of 
stories in the 
building 

Yes Int 
Length: 40 
 

CDMS will 
assume 1 if not 
populated. See 
Table 10-2 for 
acceptable 
values. 
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Attribute Description Minimum 
Requirement Field Type Comments 

FoundationType Foundation type 
of the structure 

Yes Text, 
Length: 1 

CDMS will 
assume 7 (slab 
on grade) if not 
populated. See 
Table 10-4 for 
acceptable 
values. Used to 
determine with or 
without 
basement for 
RES1 
occupancies. 

FirstFloorHt First floor height 
above grade 

No Float, 
Length: 4 
 
Default: 1 

Value should be 
locally derived. 
CDMS will 
assume 1 if not 
populated. See 
Table 10-4 for 
acceptable 
values. 

ContentCost Contents 
replacement 
value 

No Money, 
 Default: 0 

If not populated, 
CDMS will 
assume default 
value based on 
Cost and 
standard Hazus 
default contents 
value multiplier 
assumptions. 
See Hazus 
technical 
manuals or 
Hazus Analysis 
menu for specific 
multipliers. 
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Attribute Description Minimum 
Requirement Field Type Comments 

BldgDamageFnId Building 
Damage 
Function ID 

No Number, 
Length: 10 

If not populated, 
Hazus will 
assume the GBS 
default value 
based on 
Occupancy, 
Number of 
stories, and 
Foundation Type. 
See Hazus 
technical 
manuals or 
Hazus Analysis 
menu for specific 
values. 

ContDamageFnId Contents 
Damage 
Function ID 

No Number, 
Length: 10 

If not populated, 
Hazus will 
assume the GBS 
default value 
based on 
Occupancy, 
Number of 
stories, and 
Foundation Type. 
See Hazus 
technical 
manuals or 
Hazus Analysis 
menu for specific 
values. 

InvdamageFnId Inventory 
Damage 
Function ID 

No Number, 
Length: 10 

If not populated, 
Hazus will 
assume the GBS 
default value 
based on 
Occupancy, 
Number of 
stories, and 
Foundation Type. 
See Hazus 
technical 
manuals or 
Hazus Analysis 
menu for specific 
values. 
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Attribute Description Minimum 
Requirement Field Type Comments 

FloodProtection Level of 
protection 
provided by a 
dam or levee in 
Return Period) 

No Int 
 

Hazus will 
assume 0 if not 
populated. If 
near dam or 
levee, set value 
for level of 
protection in 
Return Period 
(e.g., 100 for 
protection behind 
a 100-year flood 
rated levee 

ShelterCapacity Capacity, in 
number of 
people, for 
structure 
providing 
shelter  

No Smallint, 
Length: 2 
Precision: 5 

Not used in 
Hazus. 

BUPower Is backup power 
available? 

No Bit, 
Length: 1 

No (default) = 0, 
Yes = 1. Not 
used in Hazus. 

Latitude/Longitude The location of 
the structure 

Yes Decimal, 
Length: 9, 
Precision: 11, 
Scale: 6 

Importing data in 
CDMS will pull 
location from 
spatial attributes 
of each structure 
point; manually 
entered data with 
Hazus user 
interface will 
require entering 
values when 
adding a UDF 
point. 

Census Tract The Census 
Tract where the 
UDF is located 

No Text, 
Length: 11 

 

Comment Open text field No Text, 
Length: 40 

Text field for 
additional 
information. 

 

Table 10-2 NumStories Field Description 
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Occupancy Number of Stories 
from Parcel Data 

NumStories 
Value 

RES1 1 1 

RES1 2 2 

RES1 3 3 

RES1 Split-Level 4 

RES2 1 1 

RES2 2 2 

RES2 3 3 

RES3 1–2 1 

RES3 3–4 3 

RES3 5+ 5 

All other occupancies 1–3 1 

All other occupancies 4–7 4 

All other occupancies 8+ 8 
 

Table 10-3 DesignLevel Field Description 

Year Built Design Level Value 

Prior – 1950 1 

1950 – 1970 2 

Post 1970 3 

0 (set to Null) 0 
 

Table 10-4 FoundationType Field and FirstFloorHt Field Description 

Foundation Type 
from Parcel Data 

FoundationType 
Value 

Default FirstFloorHt 
(feet) Value 

Pile 1 7 

Pier 2 5 

Solid Wall 3 7 

Basement/Yard 4 4 
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Foundation Type 
from Parcel Data 

FoundationType 
Value 

Default FirstFloorHt 
(feet) Value 

Crawl Space 5 3 

Fill 6 2 

Slab on Grade 7 1 

These values are based on Pre-FIRM construction for 
Riverine, Great Lakes, and Coastal Construction Census 
blocks as defined through the Flood Specific Occupancy 
Mapping table. 

 

10.2 UDF User-Supplied Inventory 
The creation of user-supplied inventory can require varying levels work to prepare. The extent of 
preparation and data compilation work involved depends on the condition and completeness of 
existing information, required data conversions, and the contributions of subject expertise. The 
greatest impact from enhanced inputs is produced by editing both the default inventory.  

The most detailed type of analysis incorporates the results from completed loss studies. For 
example, the output of loss estimates performed using locally developed traffic models that have 
identified the bridges most susceptible to damage can be included. Similar analyses can provide 
information on water distribution or other pipeline systems. Updates to the vulnerability ratings for 
each model building type will also produce more accurate analysis results. 

Running a baseline analysis for comparison with results after introduction of user-supplied data is 
recommended. Sensitivity of the loss estimation methodology under local conditions is measured 
best by review of outputs after inclusion of each enhanced inventory. Good record-keeping and 
inventory of documentation are essential. 

In some cases, data collected will have to be adjusted so that the inventory is classified according to 
the systems defined in the methodology. For example, a school may have two building wing additions 
that were constructed over the 40-year lifetime of the structure. Each era of construction used 
improved materials, but the best materials were used to construct the smallest addition. The 
individual responsible for assigning the building type of the school according to the Hazus 
methodology will need to define and document the criteria applied to classify the structure. The 
easiest approach is to break the facility into different entries (i.e., records). 

Consult the Hazus Comprehensive Data Management System User Guidance for specific information 
on use of that tool for data editing and entry.  
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Section 11. Advanced Hazus Analysis: Hurricane Surge 
Scenario 

The Hazus tool can run a combined hurricane and flood hazard analysis for coastal areas. To run a 
combined hurricane and flood hazard, a multi-hazard (flood and hurricane) Study Region that 
includes a shoreline must be built. To build the Study Region, follow the workflow shown in 
Table 11-1. The inputs will be used to determine the extent of flooding due to a wind-driven storm 
and estimate the flood losses associated with the hurricane. 

Table 11-1 Workflow to Build Multi-Hazard Study Region 

Model Inputs 

Hurricane  Define/Select Hurricane Scenario 
 Run Analysis with Surge-Only or Surge and 

Waves 
 Display Wind-Only Losses 

Flood  Select Storm Surge 
 Define Topography 
 Define Scenario 
 Delineate Floodplain 
 Run Flood-Only Analysis 
 Run Combined Loss Analysis 

Hurricane or 
Flood 

 Display Combined Losses 

 

11.1 Storm Surge Scenario Options 
The storm surge scenario options are available for four hurricane scenario types: 

 Historic (It is recommended when selecting from the historic data to run storm surge is 
applicable. These include observed data from recent events and additional files to improve the 
reliability of the surge data)  

 User- defined 

 Hazus import 

 Hurrevac Hurricane Hazard Import Tool (HHIT) or .stm file library import; also see the Hazus 
Hurricane Model Technical Manual  
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The storm surge scenario options are not available for: 

 Hurricane surface wind file (.dat file format) 

 Probabilistic 

To run a storm surge analysis, the Study Region must have been created for both Hurricane and 
Flood Hazard analysis. As shown in Section 3, start with create a New Region Wizard (Figure 11-1). 
Check both Flood and Hurricane hazard boxes and click Next. 

 

Figure 11-1 Select Hazards for New Region  

  
Specify the Study Region and finish the Create New Region wizard. 

NOTE: Limiting storm surge Study Regions to a single county is recommended. In some cases, a very 
large single county may need to be split into two regions. 
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Open a region and select the new multi-hazard. When prompted, select the Hurricane Model to open 
first, as shown in Figure 11-2. Click Next and then click Finish to open the region. 

 

Figure 11-2 Select Hurricane Model First in Study Region  

 
Analysis > Set Optimized Analysis Mode must be “Off,” as shown in Figure 11-3. 
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Figure 11-3 Ensure Optimized Analysis Mode is Off 

 
Check Hazard > Show Current to make sure the scenario is set to manual, Hazus import, historical, 
or Hurrevac import (Figure 11-4). If the scenario needs to be changed, use Hazard > Scenario to 
open the Scenario Management Wizard discussed previously (Figure 11-5). 

 

Figure 11-4 Review Scenario in Hazard > Show Current 
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Figure 11-5 Scenario Management Wizard  

11.2 Run Storm Surge Analysis 
Open the Analysis Options from the Analysis > Run menu (Figure 11-6). When storm surge is 
selected, as shown in Figure 11-7, a storm surge analysis using the National Oceanic and 
Atmospheric Administration (NOAA) Sea, Lake, and Overland Surges from Hurricanes (SLOSH) model 
is executed in the Hurricane Model to produce estimates of coastal still water elevations. Note that 
the storm track that is used should extend beyond the outer boundary of the applicable SLOSH basin 
grids.  
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Figure 11-6 Analysis Run Storm Surge Menu 

 

 

Figure 11-7 Analysis Options for Storm Surge 
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In addition, there are options for running coupled surge and wave analysis using the Delft University 
Simulating WAves Nearshore (SWAN) model if checked (refer to the Technical Manual for more 
details on the modeling approaches used for SWAN and SLOSH): 

 Deep water and near shore wave models. A coarse analysis of the entire northwest Atlantic basin 
is run, and the results are then coupled into one or more nearshore wave grids, which are 
superimposed on the relevant SLOSH basin(s). This option is the most detailed and slowest 
running. The storm track used should also extend all the way out to 60 degrees west longitude 
when this option is selected. 

 Near shore wave model only. This option runs a coupled surge and wave analysis within the 
relevant SLOSH basin(s) only. This option is faster than the first option but still significantly 
slower running than the “no waves” option. 

 No waves. This option skips the SWAN model entirely. For this case, the Flood Model assumes 
depth-limited waves at the coastline rather than using significant wave heights produced by 
SWAN. This is the fastest option. 

When appropriate boxes have been checked in the Analysis Options, click Run Analysis. 

At the start of the analysis, the Hurricane Model prompts the user for an initial water level in feet 
with respect to the North American Vertical Datum (NAVD) 1988 datum shown in Figure 11-8. This 
represents the water level along the coast that would have been expected (in the absence of the 
hurricane) near the center of the Study Region at the time of hurricane landfall. The initial water level 
can be estimated by using NOAA tide forecasts plus the pre-storm tidal anomaly (i.e., the difference 
between the forecast and observed water level 2 days before landfall). 

 

Figure 11-8 Provide Initial Water Level 

  
When running a coastal surge hazard analysis (Figure 11-9) in the Hurricane Model, a second 
progress dialog will appear after the wind-only damage and loss calculations are completed (Figure 
11-10). 
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Figure 11-9 Run Analysis Progress Status Window 

 

 

Figure 11-10 Run Storm Surge Progress Status Window  

 
When a hurricane coastal storm surge analysis is run, two sets of direct building losses are 
produced: one set for the wind damage by itself and a second set for the combined wind and surge 
damage. When the coastal surge analysis is complete, click the Analysis > Show Coastal Surge 
Status to confirm that the analysis was successful, as shown by the status box in Figure 11-11. 

 

Figure 11-11 Coastal Surge Status Window 



Hazus Flood Model User Guidance 

 Page 11-9 

To obtain the combined wind and surge losses, users must run a Coastal Surge analysis and 
calculate the combined losses in the Flood Model. See further instructions in the Hazus Flood Model 
Manual. 

11.3 Storm Surge 
After the Hurricane Model has been run, reopen the Study Region in the Flood Model. 

View as Flood, shown in Figure 11-12. Click Next and then click Finish to open region. 

 

Figure 11-12 Select Flood Model in Study Region 

  
Open the Hazard menu and select Flood Hazard Type (Figure 11-13). 

 

Figure 11-13 Select Flood Hazard Type 

 
Select the Flood Hazard type Storm Surge and click OK (Figure 11-14). 
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Figure 11-14 Select Storm Surge 

  
After the hazard type is set, the user must import a DEM for the Study Region by opening the Hazard 
menu and selecting the User Data dialog (Figure 11-15). 

 

Figure 11-15 Select User Data to Import DEM 

 
The User Data dialog will only contain two tabs, DEM and Storm Surge. Use the Browse button to add 
the DEM to the Model (Figure 11-16). Figure 11-17 shows the Storm Surge tab, where the Surge 
Elevation Grid (SLOSH) and Significant Wave Height Grid (SWAN) that were produced by the 
Hurricane Model are in the Study Region folder as surge.flt, surge.hdr (SLOSH), and waveht.flt, 
waveht.hdr (SWAN). When the DEM is uploaded, click OK. See the Hazus Flood Model Manual for 
more details about obtaining DEM data. 
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Figure 11-16 Add User Data DEM to Model 
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Figure 11-17 Review User Data in Storm Surge Tab 

 
When the DEM uploads successfully, the user needs to create a new scenario next, using Hazard > 
Scenario > New (Figure 11-18). Enter a unique name for the scenario and click OK (Figure 11-19). In 
the storm surge scenarios, the surge and wave height files are automatically selected, and users do 
not need to select or save any features because the Hurricane Model supports only one scenario per 
Study Region. 



Hazus Flood Model User Guidance 

 Page 11-13 

 

Figure 11-18 Select New Scenario in Hazard Menu 

 

 

Figure 11-19 Provide Name for New Scenario  

 
If the user selected No Waves in the Storm Surge analysis for the Hurricane Model, only the surge 
elevation grid was created for the Study Region. The wave height grid (waveht.flt) was not produced 
and the shoreline needs to be characterized. In this case, after creating a new scenario, the 
shoreline limits dialog will pop up, as shown in Figure 11-20. 
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Figure 11-20 Input Shoreline Limits 

  
After clicking Next, there will be an additional shoreline characterization dialog, as shown in 
Figure 11-21. The Shoreline Type tab has one required input (wave exposure). 

 

Figure 11-21 Select Shoreline Characteristics 
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The options for the wave exposure include: 

 Open coast (full exposure): Any shoreline where the storm surge and waves come directly off 
open waters without the benefit of barrier islands or other land mass protection. Think in terms 
of lines of waves marching directly onto the shoreline uninterrupted. Full exposure is the Hazus 
default. 

 Moderate exposure: Best represented by a shoreline that is slightly protected from the storm 
surge and associated waves. Moderate exposure might be a shoreline that has small islands or a 
low-lying sandbar that help break the direct force of the waves on the shoreline. A shoreline with 
moderate exposure might be angled to the direct line of the waves and will therefore receive a 
portion of the wave front. 

 Minimal exposure: Best represented by a shoreline that is not in direct line with the storm surge 
or the waves. Minimal exposure might include an exposed shoreline that is running close to 
parallel to the storm surge and is therefore not bearing the brunt of the wave fronts. 

 Sheltered: Best represented by the shoreline within a bay or protected by a larger barrier island. 
Sheltered could also be a shoreline along a large river inlet. The shoreline is sheltered from the 
wave front and is most likely subjected to stillwater flooding. 

The default parameter is Open coast (full exposure). At the top of the screen, the user can switch 
from one shoreline segment (if more than one) to another and back. If there are multiple segments 
and most have a single characteristic and a few have unique characteristics, the user can save time 
and effort by applying the common characteristic to all segments by pressing Apply to All Segments 
and then editing the unique segments. 

After selections, click Finish. 

Proceed to Delineate Floodplain by going to the Hazard Menu and selecting Coastal (Figure 11-22). 
When it is finished, the completion window will be shown as in Figure 11-23. 

 

Figure 11-22 Select Coastal to Delineate Floodplain 
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Figure 11-23 Delineate Floodplain Completion Status Window 

  
Figure 11-24 displays the completed hazard portion of a storm surge model. The coastal surge 
model outputs a flood depth grid named “Mix0_c” to the map, which comprises SLOSH and wave 
height grids. 

 

Figure 11-24 Example – Coastal Surge Floodplain Delineation 

  

The next step to complete the analysis is by using the Analysis Menu and choose Run (Figure 11-25). 
Next, check the General Building Stock Damage and Loss option and click OK (Figure 11-26). 
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Figure 11-25 Select Run in Analysis Menu 

 

 

Figure 11-26 Select Preferred Analysis Options 
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The final step of a storm surge analysis is to calculate the combined hurricane wind and coastal 
storm surge losses, using the Analysis Menu and selecting Combined Wind and Flood… 
(Figure 11-27). When the combined losses are completed, click OK to the message box 
(Figure 11-28). 

 

Figure 11-27 Select Combined Wind and Flood to Calculate Losses 

 

  

Figure 11-28 Combined Coastal Surge Status Window 

  
When the analysis options have finished running, use the Results Menu (Figure 11-29) to View 
Current Scenario Results By…, select the scenario in the drop-down, and click OK, as shown in 
Figure 11-30. 
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Figure 11-29 Select View Current Scenario Results 

 

  

Figure 11-30 Select Available Results for Surge Analysis 
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The combined losses can be viewed either in the Flood Model or in the Hurricane Model using either 
the Results > Combined Wind and Surge Loss menu (Figure 11-31 and Figure 11-32) or the Results 
> Summary Reports > Direct Losses – Combined Wind and Surge Loss summary report. An example 
results table is shown in Figure 11-33. 

 

Figure 11-31 Select Combined Wind and Flood Loss Results (Flood Model) 

 

  

Figure 11-32 Select Combined Wind and Surge Loss (Hurricane Model) 
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Figure 11-33 Example – Combined Surge Result Table 

  
Note that combined wind and surge results are available for building, content, and inventory losses 
but not for relocation, income, rental, or wage losses. The radio buttons and drop-down boxes allow 
the user to filter the losses by occupancy or building type. 

Hazus has a limit of one scenario for the Coastal Surge flood hazard type. If the user already 
completed the coastal surge model in a Study Region and decides to re-run the Hurricane Model, the 
user must delete the previous flood scenario and re-input the DEM in the User Data dialog in the 
Flood Model. 

11.4 User-supplied Storm Surge Depth Grid Analysis 
The user also has the option of importing their own coastal surge grid created outside of Hazus. To 
do this, from the Analysis menu in the Hurricane Model ensure User Supplied Coastal Surge Grid is 
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set to “YES” (Figure 11-34), then run a hurricane wind analysis for the Study Region. Once the 
hurricane analysis has completed, reopen the Study Region in the Flood Model. 

 

Figure 11-34 User Supplied Coastal Surge Grid Set to YES 

With the Study Region Flood Model open go to Hazard > Flood Hazard Type and select Storm surge 
(Figure 11-35). Click OK. 

 

Figure 11-35 Flood Hazard Type Storm Surge 

 
Next go to the Hazard > User Data menu and the User Data > Storm Surge dialog box will open as 
shown in Figure 11-36. Click Browse to navigate to your user-supplied storm surge grid and click OK.  
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Figure 11-36 Storm Surge Data Import Dialog Box 

 
Click Yes to Overwrite and Process your storm surge data (Figure 11-37). The storm surge data is now 
ready to be brought in a New Scenario and processed in the Coastal Flood Model. 
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Figure 11-37 Overwrite and Process User-Supplied Storm Surge Data 

 
Go to Hazard > Scenario > New… and name your New Scenario. The New Scenario window will open 
as shown in Figure 11-38. Click the Plus button and with the mouse drag a box around the coastal 
surge grid. Then click the Save button and click OK. Note that there is not an option to characterize a 
shoreline as seen in Section 12.3. All shoreline characterization steps are skipped when bringing in a 
user-supplied storm surge depth grid. The grid is simply selected in the User Data dialog. 

 

 

Figure 11-38 New Scenario Window 
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Next go to Hazard > Coastal > Delineate Floodplain (Figure 11-39). Click OK (Figure 11-40) and click 
Yes on the next screen (Figure 11-41). Processing will take a few minutes. Click OK on the 
Successfully Completed Coastal Flood Hazard dialog box (Figure 11-42). 

 

 

Figure 11-39 Delineate Floodplain 

 

 

Figure 11-40 Coastal Hazard Analysis 
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Figure 11-41 Process Coastal Hazard 

 

 

Figure 11-42 Successfully Completed Coastal Flood Hazard 

 
Now the user can Run > Analysis to calculate losses. It is critical to run the storm surge flood-only 
losses first, before running storm surge flood and hurricane combined losses.  
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Section 12. Advanced Hazus Analysis: Import User-
Defined Data 

Users have the option to bypass processing the DEM if they plan to run a scenario that only includes 
the flood depth grids and/or USACE Hydrologic Engineering Center’s River Analysis System (HEC-
RAS) .FLT grids. The Hazus Program recommends users import their specific flood hazard 
information from external sources via depth grids, HEC-RAS, or other hydrologic and hydraulic model. 
Note that the Flood Information Tool (FIT) is no longer supported, however, the FIT User Data tab can 
still be used to import existing FIT projects.    

  

Figure 12-1 Select FIT Tab to Import FIT Data 

12.1 Import Flood Depth Grid Results (preferred method for importing flood 
hazard information) 

While Hazus can perform hydrology and hydraulic analysis to produce flood depth rasters, 
engineering-based depth grids provide more detailed analysis and results. Users are encouraged to 
research if depth grids from engineering-based studies are available to use in the advanced analysis. 
Examples of common depth grid sources include the following: 

 FEMA’s Map Service Center MSC https://msc.fema.gov/portal/home FEMA Risk MAP program 
risk databases that include high resolution lidar based return period depth grids for many 
communities based on FEMA approved hydraulic models. 

https://msc.fema.gov/portal/home
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 Coastal Emergency Risks Assessment (CERA): https://cera.coastalrisk.live/  ADCIRC based 
current and historic storm surge data. 

 USGS Flood Inundation Mapper (FIM):  https://fim.wim.usgs.gov/fim/ 

 FEMA/USGS Base Flood Elevation Viewer: https://webapps.usgs.gov/infrm/estbfe/ return period 
depth grids by watershed for FEMA Region VI. 

 FEMA Geoplatform: https://disasters.geoplatform.gov/publicdata/NationalDisasters/ depth 
grids for significant disaster events from 2012 to present developed by FEMA to support disaster 
response and recovery 

12.1.1 Obtaining Data to Import Into Hazus From the Map Service Center 
The following steps demonstrate how to locate and download data from FEMA’s Map Service Center 
to import into Hazus.  

To obtain depth grids from the FEMA MSC flood Risk MAP databases use the following steps: 

1. Go to FEMA’s Flood Map Service Center: https://msc.fema.gov/portal/home, and select Search 
All Products 

 

Figure 12-2 FEMA Map Service Center 

 
2. Users can search by the drop-down menus, jurisdiction name, or product id.  

 

 

https://fim.wim.usgs.gov/fim/
https://webapps.usgs.gov/infrm/estbfe/
https://disasters.geoplatform.gov/publicdata/NationalDisasters/
https://msc.fema.gov/portal/home
https://cera.coastalrisk.live/
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Figure 12-3 Map Service Center Search Options 

 
3. The search results will appear in a list. When you click on the arrow, a table with the items 

available to download appears. Each item’s Product ID (name) is listed, as well as the file format, 
date, and size. To download click on the download link that is indicated by the green arrow with 
DL icon. 

 

Figure 12-4 Jurisdiction Search Results 
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Most study results will have a GeoTiff and a Geodatabase version with the depth grids. Hazus can 
process both.  

4. Data will download in a zipped file. An example of the data in the file is shown below. 

 

Figure 12-5 Geotiff Data from Map Service Center 

 
Hazus uses the WGS84 UTM Zone projection. It is important to note that the available grid data may 
use a different projection than WGS84 UTM Zone. Hazus will convert input data into ArcGIS GRID 
format and the WGS84 UTM Zone projection. However, for extremely large grid data (e.g., over 1 GB) 
or for those in a different projection, the grids can be converted outside of Hazus to optimize 
processing time in Hazus, conserve drive space and prevent potential projection issues. 

12.1.2 Importing Data Into Hazus 
To import flood depth grid results into Hazus, select User Data from the Hazard menu. In the User 
Data window, select the Depth Grid tab, as shown in Figure 12-6. The format of user supplied depth 
grids can be Esri GRID, IMAGINE (.IMG), HEC-RAS (.FLT), tagged image file (.TIF), and file 
geodatabase (fGDB).  

Use the Browse… button to navigate to the location of the flood depth grid. The browse dialog is 
intended to select a raster. After importing the flood depth grid, select the newly imported flood 
depth grid and click the Set Parameters button. A Set Parameters window will appear (Figure 12-3). 
Use the drop-down menu to select the Units (feet or meters), and then input the Return Period of the 
flood depth grid. It is important that users import the flood depth grid into the correct hazard tab. 
Repeat the process to import additional flood depth grids. 
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Figure 12-6 Select Depth Grid Tab to Import Depth Grid Data 

 

 

 Figure 12-7 Set Parameters for Depth Grid Dialog 
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12.2 Import HEC-RAS .FLT Grid Results (preferred method for importing 
flood hazard information) 

Users of HEC-RAS can import HEC-RAS (via RAS Mapper) hydraulic output .FLT grids to be used in the 
Flood Model. The HEC-RAS .FLT grids are implicitly treated as Riverine. To import HEC-RAS .FLT grid 
results into Hazus, select User Data from the Hazard menu. In the User Data window, select the HEC-
RAS tab, as shown in Figure 12-8. 

Use the Browse button to navigate to the HEC-RAS (produced via RAS Mapper) hydraulic output .FLT 
grid. The browse dialog is intended to select a floating-point binary file. After the .FLT grid is selected, 
the Flood Model validates the input by making sure the .FLT grid’s associated floodplain boundary 
(by default, HEC-RAS saves it as FloodMap) is located partially within the Study Region 
(geographically) and contains projection information (prj.adf). The Flood Model does not validate the 
integrity between the .FLT grid and the floodplain boundary polygon (by default, HEC-RAS saves it as 
FloodMap). A status bar, shown at the bottom of the window in Figure 12-8, will indicate the level of 
progress as the data is imported and validated. 

Select the newly imported .FLT grid and click the Set Parameters button. A Set Parameters window 
will appear (Figure 12-9). Use the drop-down menu to select the Units (feet or meters), and then 
input the Return Period of the flood depth grid. Repeat the process to import additional HEC-RAS 
.FLT grids. 
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Figure 12-8 Select the HEC-RAS Tab to Import .FLT Grid Data 

 

 

Figure 12-9 Set Parameters for .FLT Grid Dialog 
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